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Datum der Veröffentlichung und Softwareversion
Veröffentlicht am 14.10.2024. Basierend auf der LibreOffice Version 24.8 Community.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.

Verwendung von LibreOffice unter macOS
Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-
Version und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen 
einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfe der jeweiligen Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen LibreOffice > Einstellungen Zugriff auf die Programmoptionen

Rechtsklick Ctrl+Klick und/oder Rechts-
klick je nach Einstellungen Öffnen eines Kontextmenüs

Strg (Steuerung) ⌘ (Command) Tastenkürzel in Verbindung mit 
anderen Tasten

Alt ⌥ und/oder Alt oder Option Tastenkürzel in Verbindung mit 
anderen Tasten

F11 ⌘+T Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme
In diesem Dokument verwendete Synonyme:

für
Abschnitt
Anfasser (Punkte am Ende einer Symbolleiste)

Deck
Dialogfeld, Dialogbox
Dropdown-
Menüleiste, Hauptmenü, Menüpfad
Objektpunkte (quadratisch, rund, oval)

Popup-Menü
Register, Reiter
Tabulator
Tooltip

in diesem Dokument verwendet
Bereich
Griff(e)
Bereich
Dialog
Auswahl-
Menü
Ziehpunkte
Menü
Tab
Tabulator
Direkt Hilfe

Viele Begriffe im Bezug zu LibreOffice und den darin verwendeten Techniken finden Sie im 
Glossar. Das Handbuch Glossar wurde für alle Komponenten von LibreOffice erstellt und 
kann im Bereich Erste Schritte ganz unten heruntergeladen werden.
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Sie sehen vielleicht etwas anderes
LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von 
denen jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern 
bezüglich Schriftarten, Farben und Themen angepasst werden.
Die Bilder in diesem Handbuch wurden mit hellem Thema in Windows 10 erstellt. Das 
LibreOffice Thema entspricht der Werkseinstellungen.

Querverweise hier im Dokument
Anklickbare Querverweise hier im Dokument sehen Sie grau hervorgehoben, wenn Sie den 
Umschalter im Menü Ansicht > Feldhinterlegungen (Strg+F8) einschalten.
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Einführung
Dieses Kapitel behandelt Änderungen an Zeichnungsobjekten in der Komponente Draw 
(Draw Startbildschirm auf Seite 53) die über die Änderung von Höhe und Breite hinaus-
gehen. Dies sind zum Einen Veränderungen der optischen Erscheinung wie Farbe und 
Muster, die sogenannte Formatierung, zum anderen Änderungen der Form des Objekts. Der 
Umgang mit dem Text eines Objekts wird in einem eigenen Kapitel 9 – Text einfügen und 
formatieren dieses Handbuchs behandelt.

Formatierung
Es wird zunächst die direkte Formatierung von Zeichnungsobjekten beschrieben. Sie haben 
auch die Möglichkeit, Formatvorlagen zu verwenden, in denen die gewünschten Formatie-
rungen festgelegt sind. Durch einfache Zuweisung der Formatvorlage zu einem Zeichnungs-
objekt erhält dieses alle Formatierungen, wie sie in der Formatvorlage definiert sind. Dies 
kann beispielsweise von Vorteil sein, wenn Sie mehrere Zeichnungsobjekte mit der gleichen 
Formatierung benötigen. Wenn Sie die Formatvorlagen noch in Dokumentvorlagen ablegen, 
stehen Sie sogar dokumentübergreifend zur Verfügung.
Der Einsatz von Formatvorlagen wird auf Seite 34 beschrieben.

Formatieren von Linien
Dieser Abschnitt betrifft sowohl eigenständige Linien wie einzelne Geraden, Kurven oder 
offene Polygone wie auch die Ränder flächiger Zeichenobjekte. Viele der im Folgenden 
beschriebenen Eigenschaften treffen für alle Linien zu, manche nur für einige.
Es gibt mehrere Möglichkeiten, die Eigenschaften einer Linie zu verändern, manche sind 
direkter zu erreichen als andere, dafür bieten sie aber eventuell nicht den vollen Funktions-
umfang. Sie werden in den folgenden Abschnitten beschrieben.

Ändern des Standards für die Linie
Wenn Sie ein Zeichnungsdokument öffnen, dann sind die Linieneigenschaften auf den 
Standard eingestellt, den LibreOffice mitbringt, derzeit ist das beispielsweise eine blaue 
Linienfarbe und die Linienbreite 0,00 cm. 

Hinweis

auch die Linienbreite 0,00 cm wird übrigens gedruckt, sie benennt die 
sogenannte „Haarlinie“, die dünnste Linie, die das Ausgabemedium darstellen 
kann.

Sie können für alle Linieneigenschaften den Standard ändern, indem Sie, wenn kein Zeich-
nungsobjekt selektiert ist, die Eigenschaft auf den gewünschten Wert ändern, sofern die 
entsprechenden Auswahl- und Einstellparameter dann sichtbar sind, was nicht in allen 
Formen der Benutzeroberfläche der Fall ist. Sie wird dann mit diesem Wert für alle zukünfti-
gen Linien verwendet.
Welche Standards eingestellt sind, können Sie vollständig nur über den Dialog Linie (Menü 
Format > Linie…) nachsehen, wenn Sie ihn aufrufen, ohne dass ein Zeichnungsobjekt selek-
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tiert ist. Die Standards für Linienstil, -breite und Schatten sind auch an den Symbolen der 
Symbolleiste Linie und Füllung erkennbar, wenn kein Zeichnungsobjekt ausgewählt ist.
Eine Ausnahme bildet der Schatten, denn der Tab Schatten wird nur angeboten, wenn eine 
Linie selektiert ist, dann aber wird die Einstellung für diese Linie gezeigt. Die Standard-Ein-
stellung für den Schatten können Sie nur einsehen über Format > Fläche… > Schatten, sie 
gilt dann für Flächen und Linien gleichermaßen.

Die Symbolleiste Linie und Füllung
Abbildung 1 zeigt einen Ausschnitt dieser Symbolleiste mit den für Linien relevanten Symbo-
len. Wenn die Symbolleiste nicht sichtbar ist, können Sie sie über das Menü Ansicht > 
Symbolleisten > Linie und Füllung anzeigen.

Hinweis

Eine vollständige Darstellung der Symbolleiste Linie und Füllung mit Legende 
finden Sie unter Draw Symbolleiste Linie und Füllung auf Seite 55.

Abbildung 1: Symbolleiste Linie und Füllung (Ausschnitt)

• Beim Symbol Linienstil können Sie neben der standardmäßig verwendeten durchge-
zogenen Linie aus einem Angebot verschiedener punktierter und gestrichelter Linien-
formen wählen.

• Linienbreite bietet Pfeile , mit denen Sie die Strichstärke einstellen können; auch die 
Linienbreite 0,00 cm wird übrigens gedruckt, sie benennt die sogenannte „Haarlinie“, 
die dünnste Linie, die das Ausgabemedium darstellen kann.

• Das Symbol Linienfarbe zeigt in seinem unteren Teil die gerade aktive Farbe für 
Zuweisungen (nicht für neue Linien!) (siehe auch Symbolleiste Zeichnung unterhalb). 
Wenn Sie eine Linie ausgewählt haben und dann direkt auf das Symbol klicken, wird 
der Linie diese Farbe zugewiesen.
Wenn Sie das Dreieckssymbol rechts daneben betätigen, wird eine Abreißleiste geöff-
net, in der Sie eine andere Farbe auswählen können. Da diese auch für Flächen und 
Zeichen verwendet wird und einer ausführlichen Erklärung bedarf, wird sie in einem 
eigenen Abschnitt beschrieben (siehe „Farben“ auf Seite 29).
Auch wenn Sie eine vorhandene Linie oder ein flächiges Objekt selektieren, wird nicht 
die Farbe der vorhandenen Linie gezeigt; dies ist ein Unterschied zum Verhalten bei 
Flächen. Wenn Sie die Farbe der Linie sehen wollen, müssen Sie den Dialog öffnen 
und gegebenenfalls dort auch noch die Farbauswahl.

• Über das Symbol Schatten können Sie die Anzeige eines Schattens einschalten, was 
bei Linien eher die Ausnahme sein dürfte, denn der Schatten ist hier eine parallele 
Linie. Die Eigenschaften des Schattens können Sie nur über den Dialog Format 
(siehe Dialog Linie - Tab Schatten auf Seite 12) beeinflussen.
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• Mit dem Symbol Linienspitzen können Sie getrennt für den Anfang und das Ende 
einer Linie die Form des Endes der Linie (vor allem verschiedene Pfeilformen) wählen. 
Die Größe der Spitze wird dabei in Abhängigkeit von der Linienstärke gesetzt. Eine 
Größenänderung der Linienspitzen ist nur über den Dialog Format 
(siehe Dialog Linie - Tab Linienspitzen auf Seite 15) möglich.

Hinweis

Auch die Symbolleiste Zeichnung bietet ein Symbol gleichen Aussehens für die 
Linienfarbe an. Die beiden Symbole sind nicht synchronisiert! Das kann verwir-
ren, aber auch ein Vorteil sein, da man auf diese Weise zwei verschiedene Farben 
per einfachem Klick zuweisen kann.

Die Seitenleiste
Die Seitenleiste – einschaltbar über das 
Menü Ansicht > Seitenleiste oder Strg+F5 
– bietet Einstellmöglichkeiten an für die 
Linie (Linientyp), die Linienspitzen (beide 
Linienenden), die Breite der Linie, die 
Farbe der Linie und die Transparenz der 
Linie (Abbildung 2). Bei der Linienbreite 
wird zunächst nur eine kleine Auswahl 
vorgegebener Linienbreiten angeboten, 
aber unterhalb dieser vorgegebenen 
Linienbreiten befindet sich auch noch 
ein Kombinationsfeld, in dem Sie selbst 
einen Wert eingeben können.
Da die Seitenleiste nur dann die Eigen-
schaften einer Linie anbietet, wenn eine 
Linie oder ein Objekt, das von einer Linie 
begrenzt wird, angezeigt wird, ist es über sie nicht möglich, den Standard für neue Linien zu 
ändern.
Eine Darstellung der Draw Seitenleiste Eigenschaften mit Legende 
finden Sie auf Seite 54.

Benutzeroberflächen-Varianten
Alternativ zur klassischen Darstellung mit Menü und Symbolleisten können Sie auch unter 
verschiedenen Varianten der Darstellung mit Symbolbändern wählen, mit Ansicht > 
Benutzeroberfläche… über das Menü.
Eine Beschreibung hierzu finden Sie im
Handbuch Writer, Kapitel 21 – Varianten der Benutzeroberfläche.

Eigenschaften im Dialog Linie
Den vollständigen Umfang aller Eigenschaften können Sie im Dialog Linie anzeigen und 
ändern, den Sie über die folgenden Menüs erreichen können:

• Format > Linie…
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• Kontextmenü > Linie…

Dialog Linie - Tab Linie
Dieser Tab (Abbildung 3) enthält neben den bereits bekannten Auswahl- und Einstellpara-
meter für Linienstil, -breite, -farbe und -spitzen weitere für die Breite der Linienspitzen und 
für die Transparenz der Linie; je höher die Transparenz ist, umso stärker scheint der Hinter-
grund durch.
Bei den Linienspitzen gibt es noch Markierfelder mit der Bezeichnung Zentriert. Die Wirkung 
zeigt Abbildung 4:

Abbildung 3: Dialog Linie - Tab Linie

Abbildung 4: Linienspitzen Zentriert

Bei den linken orangenen Linien sind die unteren Enden zentriert, die oberen nicht, die vier 
blauen Quadrate an den Ecken des Selektionsrechtecks der beiden Linien markieren die 
logischen Endpunkte der idealen Linien, die ja konzeptionell ein eindimensionales Gebilde 
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sind, man sieht hier deutlich, dass die Endsymbole der Linie im unteren Fall zentriert um den 
Endpunkt gezeichnet sind, im oberen Fall enden sie von innen am Endpunkt der Linie.
Das mag für freie Linien keinen großen Unterschied bedeuten, aber bei Verbindern (siehe 
Kapitel 8 – Verbinder, Fluss- und Organisationsdiagramme dieses Handbuchs), die ja auch 
Linien sind, die aber die zusätzliche Möglichkeit des Einrastens an Objekt- und Klebepunkten 
haben, kann das wichtig sein. Der rechte Teil von Abbildung 4 zeigt oben einen Verbinder, der 
nicht zentriert ist, unten einen der links zentriert ist. Wenn man erreichen möchte, dass die 
sichtbare Pfeilspitze eines Verbinders in das Rechteck hineinragt, dass aber trotzdem der 
Verbinder auch bei Verschieben des Rechtecks mit diesem verbunden bleibt, dann ist die 
Auswahl Zentriert eine einfache Methode.
Im Tab Linie finden Sie auch noch Auswahllisten bei Ecken- und Linienendenstil für Linien-
ecken und Linienenden, die beide unabhängig voneinander und deshalb auch beliebig 
kombinierbar sind. Die Auswahlmöglichkeiten und ihre Wirkung kann man in Abbildung 5 
ersehen:

Abbildung 5: Linienecken (oben) und Linienenden (unten)

Auch hier ist die Wirkung deutlicher zu sehen, wenn die Linien breiter sind.
Die Linienecken wirken sich dann aus, wenn die Linie aus mehreren Segmenten besteht, also 
beispielsweise bei solchen, die man mit einem der Polygon-Werkzeuge zeichnet, aber auch 
bei zweidimensionalen Zeichnungsobjekten mit Ecken (Dreiecke, Rechtecke usw.) und 
Verbindern.
Die obere Reihe in Abbildung 5 zeigt die vier Varianten für die Linienecken.
Die untere Reihe in Abbildung 5 zeigt zunächst in den linken drei Fällen die Varianten für die 
Linienenden.
In der unteren Reihe ist außerdem jeweils ein anderer Linieneckenstil gewählt, um die 
Kombination der beiden Parameter zu zeigen. Beachten Sie, dass im dritten Beispiel die Ecke 
nicht wie im zweiten Fall der oberen Reihe aussieht, sondern sich die beiden angefügten 
Halbquadrate überschneiden.
Die Optionen Rund und Rechteckig fügen jeweils einen Halbkreis oder ein halbes Quadrat (in 
einer der Linienbreite angepassten Größe) an die Linie an, was die Linie etwas länger ausse-
hen lässt.
Die untere Reihe, das rechte Bild zeigt als Beispiel die übereinandergelegten Fälle für Flach 
(in gelb) und Rechteckig, man erkennt deutlich die größere Länge der dargestellten Linie in 
Form des schwarzen Halbquadrats.

Formatieren von Linien 11

https://de.libreoffice.org/get-help/documentation/


Die Wahl der Linienenden beeinflusst auch die Darstellung einer nicht durchgängigen Linie. 
Abbildung 6 verdeutlicht das anhand des im Standard mitgelieferten Linienstils Fein gestri-
chelt: die Enden jedes Abschnittes der unterbrochenen Linie werden in den unteren beiden 
Fällen durch einen Halbkreis bzw. ein Halbquadrat verlängert.

Abbildung 6: Fein gestrichelte Linie mit verschiedenen Linienenden

Dialog Linie - Tab Schatten
Der Tab Schatten (Abbildung 7) ist im Dialog Linie nur vorhanden, wenn ein „eindimensiona-
les“ Objekt wie eine Linie oder eine Kurve oder ein Verbinder selektiert wurde.
Sie können hier festlegen, ob überhaupt ein Schatten dargestellt werden soll und dessen 
Position relativ zum Zeichnungsobjekt (nach oben, unten, links, rechts, in den vier diagonalen 
Richtungen) , die Distanz zu diesem, die Schattenfarbe und deren Transparenz bestimmen.

Abbildung 7: Dialog Linie - Tab Schatten
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Dialog Linie - Tab Linienstile
Hier können Sie Linienstile ändern oder neue definieren. Der wichtige Punkt ist, dass, wie der 
Name Stil schon nahelegt, die Änderung nicht für die gerade selektierte Linie gilt, sondern 
allgemein für Draw.

Abbildung 8: Dialog Linie - Tab Linienstile

Abbildung 8 zeigt einen neu definierten Stil, der von einem der von LibreOffice mitgeliefer-
ten abgeleitet wurde. Die Anzahl der Striche und Punkte wurde verändert und auch der 
Abstand (zwischen den einzelnen Linien und Punkten).
Punkte und Striche sind hier beide Rechtecke, der Unterschied zwischen beiden besteht nur 
darin, dass ein Punkt automatisch die Länge entsprechend der Strichstärke hat (weshalb 
dieses Feld für einen Punkt in Abbildung 8 auch leer bleibt), während die Länge für einen 
Strich festlegbar ist.
Wenn Sie solche Änderungen gemacht haben und die Schaltfläche OK  betätigen, haben Sie 
die Wahl, den für diese Linie verwendeten Linienstil zu ändern – was dann für alle Dokumen-
te eines Benutzers gilt – oder einen neuen Stil zu definieren und ihm einen Namen zu geben, 
der natürlich auch systemweit gilt, aber zunächst nur dem behandelten Objekt zugeordnet 
ist.

An Linienbreite anpassen
Abbildung 8 enthält noch ein Markierfeld An Linienbreite anpassen. Wenn Sie dieses Feld 
aktivieren, bedeutet das, dass alle Angaben, die in absoluten Werten erfolgten, nun relativ 
zur Linienbreite gelten sollen; deshalb werden sie in Prozentzahlen umgerechnet.
Abbildung 9 zeigt links die Angaben des mit LibreOffice ausgelieferten Standard-Linienstils, 
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rechts die Werte nach der Umstellung auf die Anpassung auf die Linienbreite; der Linienstil 
hat einen neuen Namen, weil sich das beim Verwalten fast zwangsläufig so ergibt.

Abbildung 9: An Linienbreite anpassen: Absolute und relative Angaben

Abbildung 10 zeigt in der oberen Hälfte oben eine Linie mit der Stärke 3,5 mm, die mit dem 
in Abbildung 9 links gezeigten Stil gezeichnet wurde; direkt darunter befindet sich die 
gleiche Linie, nun aber mit dem Linienstil Linienstil1 aus der Abbildung 9, Sie sehen, dass die 
Linie gedehnt wurde.

Abbildung 10: Auswirkung von „An Linienbreite anpassen“

In der unteren Hälfte dieser Abbildung sehen Sie die gleichen beiden Linien, aber mit einer 
Stärke von nunmehr 2 mm. Die obere Linie hat sich ihrer Breite verändert, was sich in 
diesem Fall als Höhe zeigt, die Abstände und Längen der einzelnen Abschnitte ist allerdings 
gleich geblieben. Anders bei der unteren Linie: die Längen und Abstände haben sich verrin-
gert, proportional zu der Linienbreite.

Punktierte Linien
Wie schon oben gesagt, ist das, was als Typ Punkt bezeichnet wird, in Wirklichkeit ein Recht-
eck, dessen Breite der Linienbreite entspricht, also ein Quadrat. Das fällt bei feinen Linien 
nicht auf, bei größerer Strichstärke wie in Abbildung 11, obere Reihe, allerdings schon.

Abbildung 11: Normale punktierte Linie und runde Punkte

Mit einem kleinen Kniff können Sie fast runde Punkte erzeugen: Wählen Sie (Abbildung 12) 
einen Strich mit Länge 0,01 cm (wenn Sie 0 cm wählen, wird er automatisch zum Punkt, 
damit ist nichts gewonnen) und einen nicht zu geringen Abstand.
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Abbildung 12: Einstellungen des Linienstils für fast runde 
Punkte

Speichern Sie den Linienstil unter einem passenden Namen.
Wählen Sie außerdem für die Linie den Linienendenstil abgerundet. Dass sich zwischen den 
zwei Halbkreisen ein schmales Rechteck von 0,01 cm Breite befindet (Abbildung 12), fällt 
praktisch nicht auf.

Dialog Linie - Tab Linienspitzen
Dieser Tab dient weniger dem Zuordnen von Linienspitzen zu einer Linie – denn die 
Zuordnung erfolgt hier immer parallel auf beiden Seiten, getrennt geht das besser über den 
Tab Linie – , sondern der Änderung bestehender oder der Definition neuer Linienspitzen.

Abbildung 13: Spezifizierung einer benutzerdefinierten Linienspitze
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Abbildung 13 zeigt den Zustand, nachdem ein Zeichnungsobjekt als Modell für die Linien-
spitze erzeugt wurde (eine Ellipse, in der grünen Umrandung der Abbildung zu sehen) und 
dann im Menü Format > Linie > Linienspitzen gewählt wurde und im darauf automatisch 
folgenden Dialog der Name Linienspitzen 1 vergeben wurde. Beachten Sie, dass die Ellipse 
im Original waagrecht liegt wie sie dann bei einer senkrechten Linie aussieht, aber bei einer 
horizontalen Linie eine senkrechte Spitze verwendet wird.
Wenn Sie nun in diesem Dialog die Schaltfläche OK  betätigen, wird die neue Linienspitze 
gespeichert.
Den Dialog können Sie auch nutzen, um bestehende – egal, ob von LibreOffice ausgelieferte 
oder von Ihnen definierte – Linienspitzen zu ändern oder zu löschen.

Linienstil- und Linienspitzentabellen
Die Tab für Linienstile (Abbildung 8) und Linienspitzen (Abbildung 13) enthalten rechts unten 
jeweils Symbole für das Laden und das Sichern einer Datei. Damit können Sie von Ihnen 
erstellte Linienstile und Linienspitzen, die zunächst nur im Dokument gespeichert sind, für 
andere Dokumente zur Verfügung stellen.

Tabelle sichern
Mit der Schaltfläche Linienspitzentabelle sichern  werden die vorhandenen Definitionen der 
Linienstile und/oder Linienspitzen in einer Datei mit einem von Ihnen zu vergebenden 
Namen an dem von Ihnen angegebenen Ort gespeichert; die Linienstile in einer Datei mit 
Endung .sod, die Linienspitzen mit Endung .soe.
Es wird empfohlen, die von LibreOffice voreingestellten Verzeichnisse (Pfade) zu verwenden. 
Dies entspricht dem Benutzerprofil: „Der Ordner Benutzerprofil“.

Speicherorte
Beim Speichern wird Ihnen für Windows der Pfad
C:\Users\USERNAME\AppData\Roaming\LibreOffice\4\user\config

angeboten. Wobei „Users“ im Dateimanager als „Benutzer“ angezeigt wird.
Das Unterverzeichnis AppData ist in Windows ein verstecktes Verzeichnis. Geben Sie im 
Dateimanager ein: C:\%AppData% um das Verzeichnis sichtbar zu machen.
Hier finden Sie die Standardspeicherorte für die Betriebssystem Windows, GNU/Linux, 
macOS und LibreOfficePortable.

Vorsicht

Sobald Sie eine solche Tabelle gespeichert haben, ist das Dokument mit dieser 
Tabelle verknüpft und nicht mehr mit der Standard-Tabelle der Linienstile oder 
-spitzen von LibreOffice. Sollten Sie diese Tabelle später ändern, also beispiels-
weise überschreiben, ist auch dieses Dokument davon betroffen. Planen Sie also 
das Speichern dieser Tabellen sorgfältig.

Tabelle laden
Sie können eine vorhandene Tabelle der Linienstile oder der Linienspitzen in das Dokument 
laden. Diese Tabelle ersetzt die bisher verwendete Tabelle, die in der Regel die Standardta-
belle von LibreOffice sein dürfte.
Beim Laden wird Ihnen für Windows standardmäßig der Pfad
C:\Users\USERNAME\AppData\Roaming\LibreOffice\4\user\config
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angezeigt, siehe oberhalb bei „Speicherorte“.

Vorsicht

Sobald Sie eine solche Tabelle geladen haben, sind nur noch die Definitionen 
dieser Tabelle verfügbar. Vorhandene Linien behalten zwar ihre Stile und Linien-
spitzen, auch wenn sie nicht mehr in der Tabelle vorhanden sind, aber Sie können 
diese Stile oder Spitzen nicht mehr für neue Objekte vergeben. Selbst die 
Größenangaben des Stils sind nicht mehr verfügbar.

Formatieren von Flächen
Wenn wir hier die Formatierung einer Fläche behandeln, geht es immer um den inneren Teil 
einer Fläche eines Objektes; im Gegensatz dazu wird der Rand (die Umrandung) der Fläche 
als Linie betrachtet, die somit über die entsprechenden Linienfunktionen zu formatieren ist 
(siehe Formatieren von Linien auf Seite 7).
Eine Fläche kann eine Vielzahl von – teilweise voneinander abhängigen – Eigenschaften 
besitzen. In dieser Übersicht werden nur die bestimmenden Eigenschaften aufgeführt, die 
Details werden später erläutert.

• Tab Fläche: eine Füllung der Fläche kann außer mit einer Farbe auch mit Farbverläu-
fen, Bildern, Mustern und Schraffuren gefüllt werden:
◦ Schaltfläche Ohne : das Objekt besitzt keine sichtbare Fläche und ist damit 

transparent, möglicherweise einen Rand und einen Text; ohne beide ist es, außer 
in Sonderfällen, sinnlos.

◦ Schaltfläche Farbe : das Objekt besitzt eine einheitliche Farbe.
◦ Schaltfläche Farbverlauf : für das Objekt sind zwei Farben definiert, die die 

Fläche in unterschiedlicher Weise mit allen ihren Übergängen füllen; eine 
einführende Beschreibung finden Sie bei Schaltfläche Farbverlauf 
auf Seite 21.

◦ Schaltfläche Schraffur : die Fläche wird mit Linien bedeckt, die sich ein-, zwei- 
oder dreifach kreuzen. Näheres finden Sie bei Schaltfläche Schraffur 
auf Seite 26.

◦ Schaltfläche Muster : die Fläche wird mit einem Muster gefüllt, das sich aus 
Punkten zusammensetzt. Dieses Muster können Sie in einem 8x8-Raster 
definieren, siehe bei Schaltfläche Muster auf Seite 26.

◦ Schaltfläche Bild : Hier können Sie von LibreOffice zur Verfügung gestellte oder 
selbst importierte Grafiken verwenden, um die Fläche zu füllen, Näheres finden 
Sie unter Schaltfläche Bild auf Seite 24.

• Tab Transparenz: Näheres finden Sie im Tab Transparenz auf Seite 27.
• Tab Schatten: Details finden Sie im Tab Tab Schatten auf Seite 27.

Die meist wichtigsten Eigenschaften einer Fläche können Sie auf abgekürztem Weg über 
Symbolleisten setzen, den vollständigen Umfang bietet der Dialog Fläche, der in Der Dialog 
Fläche auf Seite 19 beschrieben ist. Hier folgen zunächst die direkten Zuweisungsmöglich-
keiten über die Auswahl- und Einstellparameter.
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Wie bei Ändern des Standards für die Linie auf Seite 7 gilt, dass die Änderungen den 
Standard betreffen, wenn kein Zeichnungsobjekt selektiert und das Objekt oder die Objekte, 
wenn es/sie selektiert ist/sind.

Symbolleisten und Seitenleiste
Anstatt über Menüs können Sie über Symbolleisten auf einem oft direkteren Weg ausge-
wählte Funktionen erreichen. Dazu zählt die Symbolleiste Linie und Füllung, die Sie 
gegebenenfalls über Ansicht > Symbolleisten aktivieren können, die Seitenleiste, die Sie über 
Ansicht > Seitenleiste einblenden können.
Abbildung 14 zeigt die maximal zur Verfügung stehenden Auswahlmöglichkeiten in der 
Symbolleiste Linie und Füllung für die Fläche. Das Element, das hier für die Flächenfüllung 
aus Farbeimer, Farbfläche und dem nach unten gerichteten Dreieck als Auswahlsymbol 
besteht, steht hier – als häufigster Fall – nur stellvertretend für die verschiedenen Möglich-
keiten einer Flächenfüllung; weitere Möglichkeiten sind Farbverläufe, Schraffuren, Bilder 
und Muster.

Abbildung 14: Auswahlen für Fläche in der Symbolleiste 
Linie und Füllung

Transparenz in der Seitenleiste
In der Seitenleiste (Strg+F5) enthält der Abschnitt Fläche auch Auswahl- und Einstellpara-
meter für die Transparenz. Diese sind abhängig von der Form der Transparenz 
(Abbildung 15).
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Abbildung 15: Seitenleiste Eigenschaften-Fläche-Transparenz – 
Möglichkeiten der Transparenzauswahl

• Ist keine Transparenz angegeben, dann sieht das Bild wie im linken Teil aus, der 
Eintrag im Feld Transparenz lautet dann Keine, der Einstellbalken zeigt einen Wert 
von 0 %.

• Ist die Transparenz gewählt, dann sehen Sie eine Anzeige wie im 
linken Teil mit einem Prozentwert.

• Ist dagegen ein Verlauf eingestellt, dann zeigt sich ein Bild wie im 
rechten Teil (Abbildung 15): der Listentext zeigt den Typ des 
Verlaufs, das untere ermöglicht nach Anklicken die Anzeige und 
Verwaltung der Werte Winkel, Startwert, Endwert und Umrandung 
(Abbildung 16).

Der Dialog Fläche
Die volle Kontrolle über alle Eigenschaften erhalten Sie über diesen Dialog. Wählen Sie 
Format > Fläche… im Menü. Der Dialog enthält die drei Tabs Fläche, Schatten und Transpa-
renz.

Tab Fläche
Dieser Tab enthält im Kopf sechs Schaltflächen, mit unterschiedliche Inhalten, die nach 
betätigen einer Schaltfläche einen weiteren Teil des Dialogs anzeigen (Abbildung 17).
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Abbildung 17: Kopf des Dialogs „Fläche“ und Tab „Fläche“

Schaltfläche Ohne
Hier können Sie festlegen, dass eine Fläche keine Füllung besitzt, also transparent ist.

Schaltfläche Farbe
Diese Ansicht bietet im Vergleich zum Dialog Farbfestlegung (siehe Farbfestlegung auf Seite 
30) erweiterte Möglichkeiten (Abbildung 18).
Über die Schaltfläche Auswählen…  erhalten Sie den selben Dialog, wie er schon in Der 
Dialog Farbauswahl auf Seite 31 beschrieben ist. Aber Sie können die gewünschte Farbe im 
Feld RGB-Wert Hex (hexadezimal) hier auch direkt eingeben durch Veränderung der Werte 
der drei Farbkomponenten. Die beiden Spalten rechts neben der Palette zeigen die Farbin-
formationen des derzeitigen Objekts Aktive und gegebenenfalls die geänderten Werte Neu 
für dieses Objekt an. Eine Änderung über den durch Auswählen…  aufgerufenen Dialog wird 
bei dessen Schließen mit OK  in die rechte Spalte Neu übertragen.
Eine zusätzliche Funktionalität bieten die beiden Schaltflächen links unten unter der 
Überschrift Palette anpassen: Sie können die neu definierte Farbe permanent zur Verfügung 
stellen, indem Sie auf Hinzufügen  klicken. Sie erhalten dann die Möglichkeit, der Farbe eine 
Benennung Ihrer Wahl zu geben. Die Farbe wird mit dem gewählten Namen in der Palette 
Benutzerdefiniert gespeichert.
Die so gespeicherte Farbe können Sie später – auch für Linien, Zeichen usw. – anwenden, 
indem Sie die Palette Benutzerdefiniert wählen.

Hinweis

Sie können die vordefinierten oder möglicherweise durch eine Erweiterung 
geladenen Paletten nicht ändern, dafür ist die zunächst leere Palette „Benutzer-
definiert“ vorgesehen.

Vorsicht

Wenn Sie einen Namen für eine neue Farbe vergeben, achten Sie darauf, dass 
dieser Name nicht mit schon bestehenden Namen übereinstimmt und kollidiert.
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Abbildung 18: Farbverwaltung im Dialog Fläche

Schaltfläche Farbverlauf

Abbildung 19: Farbverlauf

Abbildung 19 zeigt die Möglichkeiten, die diese Ansicht bietet. Im linken Teil können Sie unter 
vorgegebenen oder eigenen (falls erstellt) Verläufen wählen. Im mittleren Teil können Sie 
nun die Details des Farbverlaufs bestimmen.
Abbildung 20 zeigt die angebotenen Typen des Verlaufs am Beispiel eines Verlaufs von Weiß 
zu Dunkelgrün, bei einem Winkel von 0° (die Parameter werden gleich im Anschluss 
erläutert).
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Abbildung 20: Typen des Verlaufs

Abbildung 21 zeigt ein Beispiel, bei dem die Auswirkung der gesetzten Parameter deutlich zu 
erkennen ist:

Abbildung 21: Beispiel eines Farbverlaufs (grob und fein)

• Die Start- und Endfarben wurden mit Rot und Limette als deutliche Kontrastfarben 
gewählt.

• Als Typ wurde Rechteckig gewählt.
• Bei der Schrittweite wurde Automatisch ausgeschaltet und links eine sehr grobe 

Schrittweite von 10 gewählt, um das Prinzip des Farbübergangs deutlich zu zeigen. 
Rechts wurde eine Schrittweite von 50 gewählt, damit die Übergänge fließend 
erscheinen. Dies kommt dem Standard Automatisch mit einer Schrittweite von 64 
schon sehr nah.

• Bei den beiden Feldern Mitte wurde jeweils 50% gewählt, das heißt, dass der Mittel-
punkt des Verlauf dem Mittelpunkt der Fläche entspricht.

• Der Winkel beträgt 141°, das heißt, dass die Richtung (der längeren Kante) des für 
den Verlauf verwendeten Rechtecks annähernd die Diagonale von links oben nach 
rechts unten (135°) ist.

• Der Verlaufsbeginn beträgt wie beim Standard 0%, was bedeutet, dass bei der 
Färbung der Fläche der Bereich der mit der Startfarbe eingefärbt wird, nicht größer 
ist als der Bereich der anderen Abstufungen.
Erhöht man die Prozentzahl, dann wird der Bereich der Startfarbe eingefärbt, bei 
100% verschwindet der Verlauf vollständig.

An einem einfachen Beispiel ist die Wirkung der Umrandung gut erkennbar, auch wenn es 
sich hier nur um einen einseitigen Verlaufsbeginn handelt (Abbildung 22):

Abbildung 22: Wirkung der Umrandung:
links Verlaufsbeginn 0 %, rechts 40 %
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Es wurde wieder die niedrige Schrittweite 10 gewählt, damit die Abstufungen gut sichtbar 
sind; der Winkel beträgt 75°.
An diesem Beispiel kann auch gut das Prinzip der Füllung des Objekts gezeigt werden (Abbil-
dung 23): Links wurde hinter die Ellipse ein Rechteck platziert, das die Ellipse gerade einhüllt 
und das mit dem gleichen Verlauf gefüllt wurde, nur wurde zusätzlich eine Transparenz von 
30 % eingestellt, so dass dieser Hintergrund etwas blasser erscheint. Der Verlauf der Ellipse 
ist der entsprechende Ausschnitt des Rechtecks, wodurch sich die schmäleren Streifen am 
linken und rechten Rand erklären.

Abbildung 23: Prinzip der Füllung mit einem Verlauf

Der rechte Teil der Abbildung zeigt, dass bei einem Rechteck, das den gleichen Neigungs-
winkel hat, durch dieses Prinzip gerade die dreieckigen ersten und letzten Streifen am linken 
und rechten Rand abgeschnitten werden, so dass der Verlauf hier nur aus 8 Streifen 
besteht. Bei einer üblicherweise deutlich höheren Schrittweite fällt dieser Effekt nicht mehr 
auf.

Verwalten von Farbverläufen
Wenn Sie eine neue Kombination der Parameter für ein Farbverlauf erstellt haben und 
diesen für die spätere erneute Verwendung aufbewahren wollen, können Sie sie hier über 
die Schaltfläche Hinzufügen  diesen Farbverlauf abspeichern. Einen bereits vorhandenen 
Farbverlauf, den Sie geändert haben, können Sie über die Schaltfläche Ändern  speichern. 
Die Änderungen stehen dann auch anderen Dokumenten Ihrer LibreOffice-Installation zur 
Verfügung. Die Schrittweite wird dabei nicht gespeichert.
Umbenennen oder Löschen können Sie Farbverläufe über das 
Kontextmenü des Farbverlaufs-Musters (Abbildung 24).
Eine alternative Möglichkeit zur Beeinflussung einiger Parameter finden 
Sie im Menü Form > Verändern > Farbverlauf-Werkzeug oder über das 
Kontextmenü > Verändern > Farbverlauf-Werkzeug. Sie können dort den 
Mittelpunkt verschieben und den Winkel des Verlaufs bestimmen., 
außerdem über die Länge des Ziehpunktes die Größe der Umrandung 
bestimmen (Abbildung 25).
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Abbildung 25: Farbverlauf-Werkzeug

Schaltfläche Bild
In dieser Ansicht können Sie ein beliebiges Bild zum Füllen der Fläche verwenden.
Einige Bilder werden zur Auswahl standardmäßig angeboten, Sie können ein anderes Bild 
importieren über die Schaltfläche Hinzufügen / Importieren . Sie müssen sich natürlich 
überlegen, ob das von Ihnen gewählte Bild zum Füllen der Fläche geeignet ist.
Umbenennen und löschen können Sie ein solches importiertes Bild über sein Kontextmenü.
Der vorgewählte Stil ist Gekachelt, das heißt, dass das Bild so oft zum Füllen wiederholt wird, 
wie es in waagrechter und senkrechter Position in die Fläche passt bzw., dass es beschnitten 
wird, wenn es in Originalgröße zu groß für die Fläche ist. Sie können allerdings die Größe und 
Anordnung der Kacheln in mehrerer Hinsicht beeinflussen (Abbildung 26):

Abbildung 26: Kacheln einer Fläche

a) der Abbildung zeigt das Bild, das zum Füllen verwendet werden soll.
Die Größe ist 3x3 cm.

b) zeigt die Füllung einer Fläche ohne weitere Parameter: das Bild wird im Verhältnis zur 
Fläche zentriert und in senkrechter Richtung beschnitten, in waagrechter Richtung 
dagegen auf beiden Seiten wiederholt. In welcher Richtung beschnitten beziehungs-
weise wiederholt wird, hängt natürlich von der Größe der Fläche ab.

Sie können die Größe einer Kachel bestimmen, indem Sie
• das Markierfeld Skalierung unmarkiert lassen und die Breite und Höhe der Kachel in 

der eingestellten Maßeinheit (normalerweise cm) festlegen
• oder das Markierfeld Skalierung auswählen und die Größe einer Kachel als 

Prozentsatz der Breite beziehungsweise Höhe des das Objekt umgebenden Rechtecks 
bestimmen.
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In beiden Fällen wird das Bild gegebenenfalls in beiden Richtungen gedehnt oder gestaucht, 
damit es die gewünschte Höhe und Breite hat und dann so oft wie nötig in den jeweiligen 
Richtungen wiederholt.

c) zeigt eine Füllung, bei der in beiden Richtungen die Kachelgröße auf 0,5 cm einge-
stellt wurde. Ein zweiter Parameter wurde geändert, der im folgenden Punkt 
beschrieben wird.

Über die beiden Parameter Kachelposition können Sie den Versatz der Kachelung festlegen: 
Sie verschieben damit die Position des Punkts, an dem der Mittelpunkt der zentralen Kachel 
ausgerichtet ist. Bei den einfachen Verhältnissen des Beispiels passen die Kacheln gerade 
sechsmal in waagrechter und dreimal in senkrechter Richtung in die Fläche, wobei dann die 
Randkacheln in beiden Richtungen gerade in der Hälfte abgeschnitten sind.
In Teil c) wurde nun ein Versatz in waagrechter Richtung von 50 % gewählt, was bedeutet, 
dass gerade dieses Abschneiden in der Mitte ausgeglichen wird, das Muster beginnt links 
mit dem kräftig roten Kreis.

d) schließlich zeigt die Anwendung des Parameters Kachelversatz. Dieser legt den 
Versatz der Kacheln untereinander fest, im Gegensatz zum vorher beschriebenen 
Versatz des die ganze Anordnung beeinflussenden Mittelpunkt der zentralen Kachel in 
Bezug zum Flächenmittelpunkt.
Im Beispiel wurde ein Versatz von 40 % in der Zeile gewählt (man kann entweder in 
der Zeile oder in der Spalte versetzen), jede zweite Zeile der Kacheln ist somit um 
40 % gegenüber der mittigen Kernzeile nach rechts verschoben, am besten erkenn-
bar an den kräftig roten Kreisen.

Sie können außerdem die Stile Gestreckt und Benutzerdefinierte Position/Größe wählen.
Der Stil Benutzerdefinierte Position/Größe streckt oder staucht das Bild in waagrechter 
und/oder senkrechter Richtung auf die angegebene Größe. Wenn das so erzeugte Bild 
größer als die Fläche ist, wird es abgeschnitten, ist es kleiner, so füllt es nur einen mehr oder 
minder großen Teil der Fläche aus. In Abbildung 27 (Mitte) ist die Höhe 4,15 cm, die Breite 
4,33 cm, die neun Ellipsen sehen daher noch fast wie Kreise aus.
Der Stil Gestreckt füllt die Fläche mit dem Bild, indem es das Bild in X- und Y-Richtung 
soweit streckt, dass es gerade das Objekt umgebende Rechteck füllt; angezeigt wird natür-
lich nur der Teil innerhalb des Objekts. Sie sehen dies in Abbildung 27 links:
Nicht möglich ist eine Füllung der Art, wie sie in Abbildung 27 (rechts) manuell simuliert 
wurde, was in diesem einfach konstruierten Fall noch machbar ist. Eine solche Verzerrung 
eines Bildes ist in Draw nicht vorgesehen, dazu werden spezialisierte Formate und 
Programme benötigt. 

Abbildung 27: Die Parameter Gestreckt und Benutzerdefinierte Position/Größe
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Schaltfläche Muster
Im Dialog Fläche, Tab Fläche bietet die Schaltfläche Muster  eine Auswahl von Mustern, die 
auf einem 8x8-Raster basieren. Sie können die Farbe für Vorder- und Hintergrund eines 
Musters selbst bestimmen, sie sehen das Ergebnis sofort in einem Vorschaufenster 
(Abbildung 28).

Abbildung 28: Muster

Sie können auch selbst neue Muster hinzufügen oder bestehende ändern:
• Wählen Sie die Vordergrund- und Hintergrundfarbe
• im Mustereditor mit dem 8x8-Feld klicken Sie die Quadrate an, die die Vordergrund-

farbe erhalten sollen. Die Quadrate wirken als Umschalter für die Vordergrund- und 
Hintergrundfarbe.

• Verwenden Sie dann die Schaltfläche Ändern , um das gewählte Muster zu ändern 
oder Hinzufügen , um ein neues Muster zu speichern. Vergeben sie beim Speichern 
einen neuen Namen.

Sie können Muster auch umbenennen oder löschen: das Kontextmenü bietet beim Klick auf 
ein Muster der Auswahlliste beide Möglichkeiten. Wenn Sie ein Muster gelöscht haben, ist es 
innerhalb der Dokumente, in denen es verwendet wurde, weiterhin vorhanden, allerdings 
nicht als Muster, sondern als konkrete Formatierung eines Objekts. Sie können es allerdings, 
ausgehend von einem solchen Objekt, wiederum als Muster speichern, wenn die Löschung 
ein Versehen war.
Alle Änderungen stehen dann in allen Komponenten von LibreOffice zur Verfügung.

Schaltfläche Schraffur
Ähnlich wie im vorigen Abschnitt wird hier eine Auswahl an Schraffuren angeboten.
Sie können eine vorhandene Schraffur ändern oder eine neue definieren, indem Sie den 
Linienabstand, den Winkel und den Linientyp (einfach, gekreuzt, dreifach) ändern und dann 
über Ändern  oder Hinzufügen  speichern. Ansonsten gelten die im vorigen Abschnitt 
genannten Aussagen.
Alle Änderungen stehen dann in allen Komponenten von LibreOffice zur Verfügung.
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Tab Schatten
Schatten können Flächen, Linien oder Texten zugewiesen werden. Den 
aktuellen Schattenstil weist man einfach durch Anklicken des Symbols 
Schatten der Symbolleiste Linie und Füllung zu.
Eine weitere Definition des Schattens erreichen Sie über Format > 
Fläche… > Schatten oder Kontextmenü Fläche… > Schatten, wo Sie festle-
gen können, ob überhaupt ein Schatten gezeichnet werden soll und dann 
die Position relativ zum Objekt, der Abstand und die Schattenfarbe 
definieren können. Zusätzlich können Sie die Transparenz des Schattens 
festlegen (Abbildung 29).

Tab Transparenz
Sie können die Fläche eines Objekts mehr oder weniger durchscheinend gestalten, indem 
Sie die Transparenz der Fläche definieren.

Abbildung 30: Transparenz – Optionen und Prinzip des Verlaufs

Abbildung 30 zeigt die Einstellmöglichkeiten und zusätzlich die Erläuterung der Parameter 
am Beispiel eines linearen Verlaufs.
Sie können wählen zwischen:

• Keine Transparenz: die Standardeinstellung, die Fläche ist solide mit der Farbe gefüllt
• Transparenz: mit einer Prozentangabe legen Sie fest, wie weit darunter liegende 

Objekte durchschimmern: 0 % bedeutet keine Transparenz und entspricht dem 
vorigen Fall, 100 % bedeutet vollständige Transparenz und hat die gleiche Wirkung 
wie die Einstellung, dass die Fläche ohne Füllung ist. Dazwischen liegende Angaben 
lassen mit steigendem Wert ein darunter liegendes Objekt immer deutlicher erschei-
nen (Abbildung 31).
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Abbildung 31: Gelbes Quadrat mit unterschiedlichen Transparenzstufen mit blauem Kreis dahinter

• Verlauf: Hier können Sie anstatt einer gleichmäßigen Anwendung der Transparenz 
auf die gesamte Fläche die Transparenz lokal unterschiedlich einstellen, wobei Sie die 
Vielschichtigkeit des Ergebnisses durch mehrere Parameter einstellen können. Dies 
wird im folgenden Abschnitt näher beschrieben.

Auch hier gilt wieder: Wenn Sie hier Einstellungen vornehmen, ohne dass ein Zeichnungsob-
jekt selektiert ist, dann setzen Sie einen Standard, der für die zukünftig neu erzeugten 
Objekte angewendet wird.

Einstellmöglichkeiten beim Verlauf
Die Wirkung der in Abbildung 30 gezeigten Parameter bei der Wahl der Option Verlauf ist die 
gleiche wie bei der Einstellung für den Verlauf (siehe Schaltfläche Farbverlauf auf 
Seite 21), mit dem einzigen Unterschied, dass anstatt der Start- und Endfarbe hier ein Start- 
und End-Prozentwert für die Transparenz anzugeben ist, die die für die Fläche gewählte 
Farbe opaker (undurchsichtig) oder transparenter erscheinen lassen.

Farbverlauf-Werkzeug
Sie haben auch die Möglichkeit, den Farbverlauf in mancher Hinsicht direkt am Objekt zu 
beeinflussen. Das Zeichnungsobjekt muss dazu bereits einen Farbverlauf besitzen. Selektie-
ren Sie es und wählen Sie dann einen der folgenden Wege:

• Form > Verändern > Farbverlauf-Werkzeug
• Im Kontextmenü Verändern > Farbverlauf-Werkzeug

Es erscheint (wie in Abbildung 32) eine gestrichelte Linie, die zwei gefärbte Quadrate 
verbindet. Der Pfeil im Zentrum – der auf der Abbildung nur schwer zu erkennen ist, weil 
seine Größe mit der Länge der Linie korreliert – zeigt auf das Quadrat mit der Endfarbe, das 
andere Quadrat zeigt die Anfangsfarbe.

Abbildung 32: Interaktives Farbverlauf-
Werkzeug
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Was Sie mit diesem Werkzeug verändern können, hängt vom Typ des Verlaufs ab:
• Linearer Verlauf: Bewegen Sie das Endquadrat des Pfeils, um den Winkel des 

Verlaufs zu ändern das Startquadrat, um die Größe der Umrandung zu beeinflussen.
• Axialer Verlauf: nur das Zielquadrat ist beweglich: die Länge der Linie bestimmt die 

Größe der Umrandung, die Richtung den Winkel.
• Radialer Verlauf: die Lage des Zielquadrats legt das Zentrum des Verlaufs fest, die 

Länge der Linie bestimmt den Radius des Verlaufs und damit die Größe der 
Umrandung

• Elliptischer, Quadratischer und Rechteckiger Verlauf: bewegen Sie das Startquadrat, 
um durch die Länge der Linie die Größe der Umrandung und durch seine relative 
Lage zum Zielquadrat den Winkel festzulegen und das Zielquadrat, um das Zentrum 
des Verlaufs zu bestimmen.

Interaktives Transparenz-Werkzeug
Ähnlich wie das gerade geschilderte Farbverlauf-Werkzeug gibt es auch eines für die Trans-
parenz. Es besteht auch aus zwei Geraden und einem Pfeil zwischen den beiden Quadraten, 
wobei die Quadrate nicht die Start- und Endfarbe anzeigen, sondern weiß und schwarz als 
Symbol für volle beziehungsweise keine Transparenz verwenden. Das heißt, dass es genau-
genommen ein Werkzeug für den speziellen Fall eines Transparenzverlaufs darstellt. Den 
Wert für die Transparenz an sich, der sicher häufiger benötigt wird, kann man damit nicht 
einstellen. Voraussetzung ist ähnlich wie beim Farbverlauf, dass bereits ein 
von 0 abweichender Start- oder Endwert eingegeben wurde.
Der Aufruf für das Transparenz-Werkzeug erfolgt per Menü mit

• Form > Verändern > Transparenz-Werkzeug

Achtung

Das Werkzeug ist allerdings derzeit leider nicht für die Standardformen verfüg-
bar, die über die Symbolleiste Zeichnung angeboten werden, sondern nur für 
Formen, die direkt als geschlossene Kurven oder Polygone gezeichnet wurden 
oder für Textfelder. Der Fehler, dass das Werkzeug für die Standardformen nicht 
verfügbar ist, ist seit Längerem gemeldet 
(https://bugs.documentfoundation.org/show_bug.cgi?id=89565).

Farben
Vielen Objekten in Draw kann eine Farbe zugewiesen werden. Dazu gibt es verschiedene 
Wege:

• über die Menüs
◦ Format > Zeichen für Schriftfarbe, Farbe für Hervorhebungen, der Über- und der 

Unterstreichung
◦ Format > Fläche für die Flächen- und die Schattenfarbe und die Farben für einen 

Farbverlauf (siehe den Tab Schaltfläche Farbverlauf auf Seite 21)
◦ Format > Linie für die Linienfarbe
◦ die Kontextmenüs der Objekte
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• über die Symbolleisten
◦ Linie und Füllung für Linien- und Flächenfarbe
◦ Textformat für Schriftfarbe und Farbe für Hervorhebungen

• über die Farbleiste (siehe Farbleiste und Farbpalette auf Seite 33)
und wenn man eine andere Farbe als die (in manchen Fällen) vorgeschlagene wählen will, 
wird immer die Farbfestlegung (unterhalb) angezeigt, manchmal als Abreißleiste, aber auch 
– bei der Fläche – als integrierter Bestandteil des Dialogs Fläche im Tab Fläche, 
Schaltfläche Farbe auf Seite 20 näher behandelt wird.

Farbfestlegung
Abbildung 33 zeigt die Farbfestlegung am Beispiel der Linienfarbe über die Symbolleiste 
Linie und Füllung.

Abbildung 33: Farbfestlegung für 
die Linienfarbe

Die Abreißleiste hat je nach Kontext einen unterschiedlichen 
Titel! Im Zentrum steht die 12 x 10 Farbflächen anzeigende 
Farbpalette standard, aus der Sie durch einfaches Ankli-
cken eine der vorgeschlagenen Farben auswählen können.
Welche Farben dort angeboten werden, hängt von der 
gewählten Farbpalette ab, die in der Auswahlliste oberhalb 
der Farbtabelle angezeigt wird (hier standard). LibreOffice 
bringt schon bei der Installation neben der Palette 
standard einige spezielle Paletten mit (Abbildung 34), 
außerdem eine besondere mit dem Namen Benutzerdefi-
niert, in der Sie Ihre eigene Zusammenstellung von Farben 
ablegen können. Dies ist allerdings über die hier behandelte 
Farbauswahl nicht möglich, sondern nur über den Umweg 
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der Formatierung einer Fläche (die Sie dann aber abbrechen können); lesen Sie dazu Der 
Dialog Fläche auf Seite 19.
Unterhalb der Farbpalette werden unter der Überschrift Zuletzt verwendet die zuletzt 
verwendeten 12 Farben angeboten, die Sie Zeichnungsobjekten zugewiesen haben, egal, um 
welchen Objekttyp es sich handelte. So können Sie bequem eine dieser Farben erneut 
zuweisen.
Wenn die Farbe aus einer Palette gewählt wurde, zeigt die Direkthilfe (Zeigen 
mit der Maus auf die Farbfläche, Beispiel in Abbildung 35) den Namen der 
Farbe, wie er bei der Definition der Palette vergeben wurde, wenn Sie selbst 
eine Farbe bestimmt haben, wird der Hexadezimalcode der Farbe in der 
RGB-Darstellung (siehe Der Dialog Farbauswahl auf Seite 31) angezeigt.
Wenn die angebotenen Farben nicht die von Ihnen gewünschten enthalten, können Sie über 
die Schaltfläche Benutzerdefinierte Farbe…  den Dialog Farbauswahl aufrufen, der im 
nächsten Abschnitt Der Dialog Farbauswahl beschrieben wird.

Der Dialog Farbauswahl
In diesem Dialog (Abbildung 36) können Sie eine beliebige Farbe definieren, die mit dem 
vorhandenen Verfahren darstellbar ist.

Abbildung 36: Dialog „Farbauswahl“

LibreOffice bietet hier gleichzeitig drei gebräuchliche Varianten an, die ineinander 
umgerechnet werden können (vertiefte Informationen finden Sie im Internet: 
Varianten der Farbauswahl)
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• RGB: die Farben werden definiert durch das Ausmaß, in dem sie Anteile der drei 
Grundfarben Rot, Grün und Blau enthalten. Jeder der drei Variablen kann die Werte 0 
bis 255 annehmen. Diese Grenzen lassen schon erahnen, dass die eigentliche Defini-
tion über hexadezimale Zahlen erfolgt, dass also die Werte für Rot, Grün und Blau in 
hexadezimaler Darstellung jeweils aus zwei Stellen bestehen. Die knappe Darstellung 
im Feld „Hex #“ reiht einfach die drei zweistelligen Zahlen hintereinander. Die Defini-
tion einer Farbe über die Rot-, Grün- und Blau-Anteile wird intern in LibreOffice für 
die Darstellung auf dem Bildschirm verwendet.

• HSB: Eine alternative gebräuchliche und für die Praxis einfacher zu verwendende 
Vorgehensweise ist die Bestimmung der Farbe über Helligkeit, Sättigung und Farbton. 
Die Abkürzung leitet sich von den englischen Bezeichnungen Hue (Farbton), Saturati-
on (Sättigung) und Brightness (Helligkeit) her. Es ist einfacher, zunächst grundsätzlich 
die Farbe auszuwählen und dann über die Sättigung die Bedeutung der Farbe gegen-
über dem neutralen Grau und die Helligkeit festzulegen; dies geschieht so auch über 
die Farbflächen im linken Teil des Dialogs, die weiter unten besprochen werden.
Helligkeit und Sättigung werden dabei als Prozentzahl angegeben, der Farbton als 
Grad-Angabe zwischen 0° und 360°, weil dem Modell ein Farbkreis zugrunde liegt.
LibreOffice rechnet diese Werte in die RGB-Werte um, mit denen es intern arbeitet.

• Die CMYK-Darstellung der Farbe wird beim Druck verwendet. Der Druck arbeitet mit 
einem subtraktiven Modell, das bedeutet wenn keine Farbe gedruckt wird, erscheint 
weiß, die Farbe des Papiers, während am Bildschirm Weiß als Summe aller drei 
Primärfarben erzeugt wird, was ein additives Verfahren ist. Das CMYK-Modell arbeitet 
mit den vier Komponenten Cyan, Magenta, Yellow und Key (Schwarz).
LibreOffice rechnet diese Werte in die RGB-Werte um, mit denen es intern arbeitet.

Sie haben somit die Möglichkeit, die Farbe je nach Ihren Erfordernissen zu definieren. Die 
erste und dritte Variante dürfte eher durch Forderungen von außen benötigt werden, die 
mittlere ist in vielen Fällen die am leichtesten verständliche.
Die Handhabung des Dialogs ist nicht ganz selbstverständlich, sie wird zunächst im Fall HSB, 
wo die verwendeten Parameter am ehesten mit der sichtbaren Realität in Verbindung 
gebracht werden können, erläutert, anschließend dann für die anderen Fälle ergänzt.

HSB
Der Dialog bietet bei dieser Auswahl drei Parameter an; einer wird als primärer Parameter 
durch eine lineare Schaltfläche repräsentiert; im Standard ist das, wie in Abbildung 36 zu 
sehen, der Farbton, der rechts in einem schmalen senkrechten Farbbalken dargestellt wird, 
der eine lineare Abstufung repräsentiert. Die anderen beiden Parameter definieren links 
eine Farbfläche, die je nach Auswahl des primären Parameters unterschiedliche Anzeigen 
bietet; in der Abbildung steigt die Sättigung von links nach rechts, die Helligkeit nimmt von 
oben nach unten ab.
Probieren Sie auch die anderen beiden Varianten aus, vielleicht sagt Ihnen eine andere 
besser zu.
Bei der linken Fläche können Sie den Kreis mit der Maus verschieben, um die Anteile der 
Komponenten Helligkeit und Sättigung einzustellen, bei der rechten können Sie über den 
durch die Zeiger links und rechts angedeuteten Schieber den Farbton wählen, indem Sie an 
der gewünschten Stelle in das Feld klicken. Alternativ können Sie natürlich die Werte im 
Abschnitt HSB direkt ändern.
Das Ergebnis einer Änderung, egal mit welchen Mitteln Sie sie vorgenommen haben, wird in 
den zwei Flächen unterhalb der großen Farbfläche für Sättigung und Helligkeit angezeigt:
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• die linke zeigt die neue Farbe aufgrund Ihrer Änderungen, die durch OK  dann 
zugewiesen würde,

• die rechte zeigt die bisher benutzte Farbe.
Durch die Betätigung der Schaltfläche OK  wird der Dialog geschlossen, die Farbe wird in 
das entsprechende Feld des rufenden Dialogs übertragen.

RGB
Die Vorgehensweise ist die gleiche wie bei HSB, allerdings ist das Verhalten schwieriger zu 
verstehen,denn durch eine Verschiebung des durch einen Kreis markierten Punktes im 
linken Feld ändert sich auch die Abstufung im rechten linearen Feld, das ja jeweils die 
Farben zeigt, die sich in Kombination des veränderlichen primär gewählten Farbanteils mit 
den durch die Position des Kreises fixierten Anteilen der beiden anderen Farben ergeben.

Farbleiste und Farbpalette
Eine weitere Möglichkeit, die Farben von Objekten zu beeinflussen, bietet die Farbleiste. Sie 
können sie aktivieren und deaktivieren über das Menü Ansicht > Farbleiste.
Meist wird die Farbleiste dann als weitere Seitenleiste in der Funktion als Abreißleiste rechts 
angezeigt (Abbildung 37).

Abbildung 37: Farbleiste als Abreiß-Seitenleiste

Abbildung 38: Farbleiste „abgerissen“

Sie können die abgerissene Farbleiste in Breite und Höhe durch Klicken-Halten-Ziehen 
verändern. Dies erfolgt am äußeren Rahmen der Farbleiste. Dadurch sind, je nach Größe des 
Fensters, mehr Farben direkt auswählbar.

Zuweisung von Farben
1. Wählen Sie eine Form oder einen Text aus

Farben 33



2. Klicken Sie mit der linken Maus-Taste auf eine Farbe: 
die Flächenfarbe beziehungsweise die Textfarbe wird geändert

3. Klicken Sie mit der rechten Maus-Taste auf eine Farbe: 
die Linienfarbe wird geändert

Gegebenenfalls wird auch eine bisher nicht sichtbare Fläche oder Umrandung erst einge-
blendet. Die Flächen- und Linienfarbe können Sie auch durch Ziehen der Farbe mit der Maus 
auf die gewünschte Fläche oder Linie zuweisen.
Sie können eine Linien-, Flächen- oder Textfarbe setzen bei markiertem Objekt:

1. Klicken Sie mit der linken Maus-Taste auf eine Farbe: 
die Flächenfarbe beziehungsweise die Textfarbe wird geändert und mit den Pfeil-
Tasten können Sie eine andere Farbe wählen.

2. Klicken Sie mit der rechten Maus-Taste auf eine Farbe: 
die Linienfarbe wird geändert und mit den Pfeil-Tasten können Sie eine andere Farbe 
wählen.

Farbpalette
Sie können die Symbolleiste Farbleiste abreißen. Zum Abreißen klicken Sie in den freien 
Bereich der Farbleiste und ziehen dann mit der Maus den Fokus irgendwo anders hin, wenn 
Sie die Maus-Taste loslassen, wird die Farbleiste dort angezeigt.
Um die Farbleiste wieder anzudocken, doppelklicken Sie bei gedrückter Strg-Taste in den 
grauen Bereich rund um die Farben; bei der Titelleiste hat dieses Vorgehen keine Auswir-
kung. Sie können die Farbleiste jedoch auch wie andere Fenster andocken, der Bereich, in 
dem dies möglich ist, ist jedoch gerade am unteren Rand recht klein.

Formatvorlagen
Hinweis

Lesen Sie als Ergänzung eventuell das
Kapitel 3 – Einführung in Formate und Vorlagen des Handbuchs Erste Schritte
Kapitel 4 – Objekteigenschaften ändern des Handbuchs Draw
Formatvorlagen in Draw im TDF-Wiki

Formatvorlagen bündeln Formatierungen in einer eigenen Einheit, die Sie dann immer 
wieder nutzen können, um all diese Eigenschaften mit einer einfachen Zuweisung auf ein 
Objekt zu übertragen. So können Sie mehrfache Arbeit beim Formatieren einsparen und 
leicht ein einheitliches Erscheinungsbild erreichen.
Der Einsatz von Formatvorlagen liegt in Draw vielleicht nicht so auf der Hand wie in Writer, 
wo ein Dokument leicht Hunderte von Absätzen haben kann, von denen viele dann gleichar-
tig formatiert sein sollten; da ist es selbstverständlich, dass man da die Formatvorlage 
Fließtext entsprechend anpasst oder eine eigene Vorlage einsetzt.
In Draw kann man sich oft ohne Formatvorlagen behelfen, indem man Zeichnungsobjekte 
mit ihren Formatierungen kopiert und dann das Objekt verändert oder indem man das 
Format über das Symbol Formatierung übertragen nachträglich ändert.
Wirklich schlagkräftig wird das Konzept der Formatvorlagen allerdings in Verbindung mit 
einer Dokumentvorlage: diese enthält dann eine Reihe von Formatvorlagen und wird als 
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Ausgangsbasis zum Erstellen neuer Dokumente verwendet, die dann sogleich alle dort 
enthaltenen Formatvorlagen erben, die Sie somit sofort verwenden können.

Hinweis

Formatvorlagen enthalten, da sie alle von universellen, mit LibreOffice ausgelie-
ferten Vorlagen abstammen, auch Attribute, die für die Objekte, für die sie 
gedacht sind, gar nicht zutreffen. Solche Attribute werden ggf. einfach ignoriert.

Formatierung mittels einer Formatvorlage
LibreOffice enthält für Draw bereits eine kleine Auswahl von Formatvorlagen für Zeichnungs-
objekte. Für die Anzeige der Formatvorlagen wird die Seitenleiste genutzt. Wenn diese nicht 
angezeigt wird, können Sie sie auf folgenden Wegen aufrufen:

• Ansicht > Formatvorlagen (F11)
• Format > Formatvorlagen > Formatvorlagen verwalten (F11).
• Ansicht > Seitenleiste (Strg+F5) und dort dann in der rechten Registerleiste das 

Symbol Formatvorlagen (Alt+F2) auswählen.
Markieren Sie ein Zeichnungsobjekt und doppelklicken Sie dann auf die gewünschte 
Formatvorlage. Die Vorlage wird dann dem Objekt zugewiesen.
Abbildung 39 auf Seite 36 zeigt die im Standard in LibreOffice vorhandenen Vorlagen in der 
hierarchischen Darstellung, auf die wir später noch zurückkommen. Nicht alle Vorlagen 
werden im Beispiel dargestellt, erkennbar an den +-Zeichen vor manchen Einträgen.
Die Art der Darstellung der Formatvorlagen wählen Sie über die Auswahlliste am Fuß der 
Seitenleiste.

Die Hierarchie von Formatvorlagen
Formatvorlagen sind – nicht nur in Draw – hierarchisch organisiert: eine Vorlage basiert 
immer auf einer anderen. Die in der Hierarchie oberste Formatvorlage heißt Grafik 
(in älteren LibreOffice Versionen hieß sie Standard).
LibreOffice liefert eine Hierarchie aus, die Sie durch eigene Vorlagen ergänzen können; aller-
dings können Sie die von LibreOffice gelieferten Vorlagen nicht löschen, sondern nur die 
selbst erzeugten. Die Hierarchie sehen Sie teilweise in Abbildung 39.
Der Vorteil der Hierarchie ist, dass Sie allgemeingültige Eigenschaften auf einer höheren 
Ebene, speziellere auf einer niedrigeren ablegen können, so dass jeweils nur an einer Stelle 
geändert werden muss, wenn der Bedarf besteht.

Hinweis

Ein einfaches Beispiel: Sie möchten gern, dass alle Texte in Ihrer Zeichnung die 
gleiche Schriftart und -größe verwenden, also erzeugen Sie zunächst eine 
Vorlage auf der Basis der Vorlage Grafik, bei der Sie die gewünschten Änderun-
gen eingeben. Da die Vorlage auch für Textfelder gelten soll, die üblicherweise 
weder Flächenfarbe noch Umrandung haben sollen, setzen Sie diese beiden 
Eigenschaften auf Ohne. Dann möchten Sie für Flächen drei Farben verwenden, 
also richten Sie unter der gerade definierten Vorlage drei weitere ein, bei der Sie 
die Flächenfarbe und gegebenenfalls die Umrandung entsprechend setzen und, 
wenn es eine dunkle Farbe ist, wählen Sie vielleicht auch noch eine helle 
Schriftfarbe.
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Abbildung 39: Seitenleiste Formatvorlagen - Sortierung Hierarchisch

Ändern einer Formatvorlage
Sie können eine bestehende Formatvorlage ändern, wenn Sie sie in der Seitenleiste 
(Strg+F5) rechtsklicken und den Befehl Vorlage bearbeiten… aus dem Kontextmenü wählen.
Das Ändern einer von LibreOffice gelieferten Vorlagen hat jedoch eventuell den Nachteil, 
dass ein Zeichnungsobjekt, das Sie aus einem anderen Dokument kopieren, in Ihrem 
Dokument plötzlich anders aussieht. Existiert nämlich die Formatvorlage, die dem kopierten 
Objekt im Quelldokument zugewiesen wurde, auch im Zieldokument, dann wird sie dem 
kopierten Dokument wiederum zugewiesen, auch wenn sie vielleicht ganz andere Eigen-
schaften hat. Es wird daher in den allermeisten Fällen sinnvoll sein, einen neue Vorlage mit 
einem genügend speziellen Namen zu erstellen, um solche Überschneidungen zu vermeiden.
Einen neue Vorlage erstellen Sie, indem Sie in der Seitenleiste die Vorlage, von der Sie eine 
neue Vorlage ableiten wollen, mit der rechten Maus-Taste anklicken und im Kontextmenü 
Neu wählen. Vergeben Sie einen neuen Namen für die Vorlage und setzen Sie die gewünsch-
ten Eigenschaften. Klicken Sie dann auf OK . Die neue Vorlage ist der vorher Ausgewählten 
hierarchisch untergeordnet. Die neue Vorlage ist im Dokument gespeichert.
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Erstellen oder Ändern einer Formatvorlage aus einem ausgewählten Objekt
1. Wählen Sie das Zeichnungsobjekt aus, das die Grundlage für die neue Formatvorlage 

bildet.
2. Wählen Sie die Formatvorlage aus, auf der die neue Formatvorlage basieren soll, der 

sie also in der Hierarchie untergeordnet werden soll.
3. Wählen Sie das Symbol Neue Vorlage aus Auswahl  oben in der Seitenleiste.
4. Alternativ über das Menü Format > Formatvorlagen > Neue Formatvorlage aus 

Auswahl…
5. Im folgenden Dialog Neue Formatvorlage aus Auswahl können Sie der neuen Format-

vorlage einen Namen geben und speichern Sie sie dann mit OK .

Vorsicht

Dieser Dialog zeigt auch die bereits vorhandenen Anwendervorlagen an und Sie 
können auch eine bestehende auswählen. Sie werden dann noch einmal gefragt, 
ob Sie die Formatvorlage überschreiben wollen. Wenn Sie das bejahen, wird sie 
tatsächlich geändert.
Das hat jedoch den Nachteil, dass bereits vorhandene Zeichnungsobjekte, die 
diese Formatvorlage verwendeten, die Beziehung zu ihr verlieren und mit der 
hierarchisch darüber liegenden verbunden werden. Man kann dieses Vorgehen 
allerdings gut verwenden, wenn man sich noch im Entwurf der Formatvorlage 
befindet und am Testobjekt für diese Vorlage Änderungen durch direkte Forma-
tierung ausprobiert hat, die nun in die Vorlage übernommen werden sollen.
Besser ist jedoch das in Ändern auf Basis eines Objekts auf Seite 37 beschrieben 
Verfahren.

Sie können die Zuordnung zur übergeordneten Vorlage auch ändern, indem Sie im Tab Allge-
mein beim Feld Basierend auf die gewünschte Vorlage auswählen oder in der hierarchi-
schen Darstellung (siehe Die Hierarchie von Formatvorlagen auf Seite 35) die ausgewählte 
Formatvorlage mit gedrückter Maus-Taste unter die Vorlage verschieben, der sie unterge-
ordnet sein soll. Wenn Sie einen waagrechten Strich an der richtigen Stelle sehen, lassen Sie 
die Maus-Taste los.

Ändern einer Formatvorlage
Sie haben die folgenden Möglichkeiten um Formatvorlagen zu ändern:

• Wählen Sie in der Seitenleiste in der Liste der Formatvorlagen mit einem Rechtsklick 
die gewünschte Vorlage und dann im Kontextmenü Vorlage bearbeiten…

• Öffnen Sie bei einem Objekt, das diese Formatvorlage verwendet, durch Rechtsklick 
das Kontextmenü und wählen Sie Formatvorlage bearbeiten…

• Selektieren Sie ein Objekt, das diese Formatvorlage verwendet und wählen Sie 
Format > Formatvorlagen > Formatvorlage bearbeiten...

Nehmen Sie dann im Dialog Zeichnungsvorlagen die gewünschten Änderungen vor und 
bestätigen Sie diese mit OK .

Ändern auf Basis eines Objekts
Wenn Sie bei einem Zeichnungsobjekt, das auf einer Formatvorlage beruht, eine Änderung 
vorgenommen haben, die Sie gerne in die Formatvorlage übernehmen möchten, dann selek-
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tieren Sie das Objekt und wählen dann das Symbol Formatvorlage aktualisieren . Alterna-
tiv können Sie das Objekt selektieren und dann Format > Formatvorlagen > Ausgewählte 
Formatvorlage aktualisieren wählen.
Selbst wenn Sie versehentlich nach dem Selektieren des Objekts eine andere Formatvorlage 
in der Seitenleiste ausgewählt haben sollten, wird die korrekte Formatvorlage aktualisiert.

Löschen einer Formatvorlage
Hinweis

Sie können nur benutzerdefinierte Formatvorlagen löschen, bei anderen ist der 
Menüpunkt ausgegraut.

1. Wählen Sie die zu löschende Formatvorlage in der Seitenleiste aus
2. Wählen Sie im Kontextmenü Löschen
3. Wenn die Formatvorlage noch für Zeichnungsobjekte verwendet wird, erscheint ein 

Dialog Bestätigung mit entsprechender Information, der Sie warnen soll, so dass Sie 
das Löschen noch abbrechen können (Abbildung 40).

4. Wenn Sie das Löschen mit Ja  bestätigt haben oder gar keine Warnung kam, wird die 
Formatvorlage gelöscht.

Abbildung 40: Dialog Bestätigung

Wenn Sie sehen wollen, welche Formatvorlagen 
verwendet werden, wählen Sie Verwendete Vorlagen in 
der Auswahlliste am Fuß der Seitenleiste (Abbildung 41).

Dokumentvorlagen verwenden
Wenn Sie die gleichen Formatierungen immer wieder in 
neuen Dokumenten verwenden wollen, empfiehlt sich 
oft die Erstellung einer Dokumentvorlage. Erstellen Sie 
dazu in einem Dokument die erforderlichen Formatvor-
lagen; das Dokument kann daneben auch andere 
Inhalte wie Textfelder Bilder und so weiter enthalten, die 
in neu zu erzeugenden Dokumenten auch immer 
vorhanden sein sollen.
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Speichern Sie dann das Dokument über Datei > Dokumentvorlagen > Als Dokumentvorlage 
speichern…
Das Dokument erhält die Endung [ODF – Zeichnungsvorlage (*.otg)]. Wenn Sie dieses 
Dokument öffnen, wird automatisch eine Kopie als neues Dokument erzeugt, das dann 
wieder ein normales Zeichnungsdokument mit der Endung [ODF – Zeichnung (*.odg)] ist, das 
alle Inhalte und insbesondere alle Formatvorlagen schon enthält (Abbildung 42).

Abbildung 42: Prinzipdarstellung Dokumentvorlage wird zu Dokument.

Näheres finden Sie in Kapitel 3 – Einführung in Formate und Vorlagen des Handbuchs Erste 
Schritte.

Weitere Formatänderungen eines Objekts
Draw bietet noch weitere Werkzeuge, um die Form eines Zeichnungsobjekts (im weiteren 
Sinn) zu ändern. Diese sind unter dem Begriff Umwandlungen zusammengefasst (Abbildung 
43); vergleichen Sie aber auch Umwandeln auf Seite 47.
Sie können diese Funktionen aufrufen über:

• das Symbol Verändern in der Symbolleiste Linie und Füllung
• die Symbolleiste Verändern, die Sie dann gegebenenfalls über das Menü Ansicht > 

Symbolleisten > Verändern einblenden müssen (Abbildung 43)
• das Menü Form > Verändern
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Abbildung 43: Symbolleiste Verändern

Drehen
Selektieren Sie ein Objekt. Dann versetzen Sie es in den Drehmodus, indem Sie eine der 
folgenden Möglichkeiten wählen:

• Klicken Sie ein weiteres Mal auf das Objekt: die Ziehpunkte ändern sich in Kreise oder 
Ellipsen.

• Wählen Sie das Symbol Verändern in der Draw Symbolleiste Linie und Füllung (auf 
Seite 55). Dieses Symbol ändert sich aufgrund Ihrer Auswahl in der Vergangenheit, 
direkt durch Klicken ausführbar ist nur die Funktion, die bereits zuletzt ausgeführt 
wurde. Wenn das angezeigte Symbol nicht das für die Drehung ist, klicken Sie auf das 
Dreieckssymbol rechts neben dem Symbol, um die Drehfunktion auszuwählen.

Form und Farbe der Ziehpunkte des Rechtecks ändern sich, zusätzlich erscheint im Zentrum 
ein weiterer Punkt, der Drehpunkt (Abbildung 44).
Zeigen Sie nun mit dem Cursor auf einen der Eckziehpunkte, das Symbol ändert sich wie in 
der Abbildung 44 gezeigt. Mit gedrückter linker Maus-Taste können Sie nun den Drehwinkel 
ändern. (Das Cursorsymbol für das Drehen ist im Bild aus technischen Gründen etwas 
verschoben.)
Alternativ können Sie den Drehwinkel über Kontextmenü Position und Größe > Drehung oder 
über Format > Position und Größe > Drehung oder in der Seitenleiste bei Eigenschaften und 
dort Position und Größe > Drehung ändern.
Der Drehpunkt befindet sich standardmäßig im Zentrum des Objekts. Sie können ihn mit der 
Maus verschieben (klicken-halten-ziehen). Wenn Sie dann eine Drehung ausführen, 
geschieht sie um diesen veränderten Drehpunkt. Abbildung 45 zeigt dies am Beispiel einer 
Gruppe von zwei Formen.
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Abbildung 44: Objekt im Drehmodus

Abbildung 45: Drehen einer Gruppe von zwei 
Formen mit exzentrischem Drehpunkt

Wenn Sie beim Drehen die Umschalt-Taste betätigen, erfolgt die Drehung standardmäßig in 
15°-Grad-Schritten. Die Schrittweite können Sie über Extras > Optionen... > LibreOffice Draw 
> Raster > Beim Drehen ändern.

Hinweis

Das beschriebene Verhalten entspricht dem Standard, wie er von LibreOffice 
ausgeliefert wird, dass nämlich in Extras > Optionen > LibreOffice Draw Raster > 
Objekte beschränken > Beim Drehen kein Haken gesetzt ist. Wenn Sie den Haken 
setzen, ist das Verhalten gerade umgekehrt: ohne Umschalt-Taste erfolgt die 
Drehung in der eingestellten Schrittweite, mit Umschalt-Taste kontinuierlich.

Drehen ohne Maus
Wenn das Objekt im Drehmodus ist, können Sie über Strg+Tabulator beziehungsweise in 
umgekehrter Reihenfolge über Strg+Umschalt+Tabulator die einzelnen Punkte des Objekts 
aktivieren, zuerst den Drehpunkt, dann die Ziehpunkte.
Mit den Pfeil-Tasten können Sie nun die Drehung beeinflussen:

• Verschiebung des Drehpunkts
• Drehung um einen Eckziehpunkt dreht das Objekt
• Verschieben eines Seitenmittelpunkts ändert die Form: das Objekt wird mehr oder 

weniger verzerrt oder entzerrt.

Weitere Formatänderungen eines Objekts 41



Spiegeln
Das Werkzeug Spiegeln aus der Symbolleiste Verändern ermöglicht die Spiegelung an jeder 
gewünschten Achse. Für die Standardfälle der waagrechten und senkrechten Spiegelung 
gibt es eine direktere Alternative.

Direktes Spiegeln
Wenn Sie ein Objekt an seiner waagrechten oder senkrechten Mittellinie spiegeln wollen, 
können Sie das schneller auf einem der folgenden Wege erreichen:

• im Kontextmenü wählen Sie Spiegeln
• im Menü Form > Spiegeln
• Seitenleiste/Eigenschaften Position und Größe
• per Symbolleiste Linie und Füllung

In allen Fällen werden dann die Möglichkeiten Horizontal und Vertikal angeboten.

Spiegeln an einer beliebigen Achse
Wenn die Spiegelachse nicht eine der beiden genannten Mittelachsen sein soll, gehen Sie 
folgendermaßen vor:

1. Selektieren Sie das Objekt.
2. Wählen Sie das Symbol Spiegeln aus der Symbolleiste Verändern.
3. Es erscheint eine gestrichelte Linie mit Ziehpunkten an beiden Enden (Abbildung 46, 

Bild a), die die Spiegelachse symbolisiert.
4. Sie können nun diese Achse verschieben (Abbildung 46, Bild b):

◦ indem Sie die beiden Ziehpunkte mit der Maus verschieben: so können Sie sowohl 
den Winkel als auch die Spiegelachse im Verhältnis zum Objekt verändern.

◦ indem Sie die Spiegellinie zwischen den beiden Endziehpunkten mit der Maus 
verschieben (mit klicken-halten-ziehen der Linie): hier bleibt der Winkel erhalten.

◦ Indem Sie das Objekt mit der Maus oder den Pfeil-Tasten verschieben: auch hier 
bleibt der Winkel erhalten.

◦ Indem Sie Strg+Tabulator drücken, dann ist die Linie selektiert, ein weiteres Mal 
Strg+Tabulator drücken, dann ist der erste Ziehpunkt markiert, noch ein weiteres 
Mal Strg+Tabulator markiert den zweiten Ziehpunkt. Sie können das so markierte 
jeweilige Element mit den Pfeil-Tasten verschieben.
Selbstverständlich können Sie wie sonst auch mit Umschalt+Strg+Tabulator die 
Elemente in der umgekehrten Richtung durchlaufen.

5. Klicken Sie nun einen der acht Ziehpunkte des Objekts an; der Mauszeiger ändert 
sein Symbol. Bewegen Sie bei gedrückter Maus-Taste den Zeiger über die Spiege-
lachse hinweg, bis ein Phantombild des gespiegelten Objekts erscheint (Abbildung 
46, Bild c).

6. Lassen Sie die Maus-Taste los, das Objekt ist dann gespiegelt.
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Abbildung 46: Spiegeln an einer Achse

Wenn Sie beim Verschieben der Endziehpunkte der Spiegellinie die Umschalt-Taste gedrückt 
halten, wird der Winkel auf Vielfache von 45° beschränkt.
Die Länge der Spiegellinie hat keine Auswirkungen, ebenso wenig ihre Lage auf der durch sie 
der Länge nach hindurch gehenden Geraden.

In einen 3D-Rotationskörper umwandeln
Abbildung 47 zeigt ein Beispiel für die Anwendung dieses Werkzeugs.

1. Selektieren Sie das Objekt (in diesem Fall die Form Puzzle aus den Symbolformen, 
links im Bild). Sie können auch mehrere Objekte auswählen.

2. Wählen Sie die Symbolleiste Verändern, wie in Weitere Formatänderungen eines 
Objekts auf Seite 39 beschriebenen.

3. Wählen Sie das Symbol In 3D-Rotationskörper.
4. Es erscheint ein gespiegeltes Phantombild des Objekts mit der Spiegelachse dazwi-

schen. Diese Achse können Sie wie beim Spiegeln verschieben.
5. Klicken Sie außerhalb der Form auf die Arbeitsfläche; kurz danach erscheint das 

erzeugte 3D-Objekt, wie im dritten Teil der Abbildung zu sehen.
6. Um den Rotationskörper ganz rechts zu erzeugen, wurde der untere Ziehpunkt der 

Spiegellinie leicht nach rechts verschoben, so dass sich die Puzzleteile in der Mitte 
leicht überschnitten. Schon leichte Änderungen der Achse können deutlich andere 
Körper erzeugen!

Abbildung 47: Umwandlung in einen 3D-Rotationskörper
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Drehen des Rotationskörpers
Wie andere Zeichnungsobjekte auch (siehe Kapitel 3 – Arbeiten mit Objekten und 
Objektpunkten des Handbuchs Draw) können Sie den Rotationskörper auch drehen. Klicken 
sie dazu zweimal (kein Doppelklick!) auf den Rotationskörper, damit die Drehpunkte erschei-
nen. Sie können nun den Körper drehen, indem Sie einen der acht Ziehpunkte anklicken und 
mit gedrückter Maus-Taste die Maus verschieben. Der Mauszeiger verändert sich dabei in 
ein Drehsymbol. Abbildung 48 zeigt das Ergebnis für den in Abbildung 47 im vorletzten Bild 
gezeigten Körper, nachdem der Mauszeiger vom Drehpunkt rechts oben in etwa in die Positi-
on verschoben wurde, die das Drehsymbol anzeigt.

Abbildung 48: gedrehter Rotationskörper

Die Drehpunkte haben unterschiedliche Wirkungen:
• Die Eckziehpunkte bewirken das Gleiche, nämlich eine Drehung des Objekts um die 

Achse, die senkrecht zur Bildschirmoberfläche steht.
• Die senkrechten Seitenmittelpunkte links und rechts kippen den Körper um die 

waagrechte Achse der Bildschirmoberfläche.
• Durch Ziehen am Objekt selbst kann um die waagerechte und die senkrechte Achse 

in einem Zug gedreht werden.
Der zentrale Punkt, in Abbildung 48 mit einer Art Fadenkreuz gekennzeichnet, ist das 
Zentrum der Drehung. Sie können ihn verschieben, die waagerechte Achse wird senkrecht 
verschoben, die senkrechte Achse wird waagerecht verschoben, die  senkrecht zur Zeichen-
ebene stehende Achse wird waagerecht und senkrecht verschoben.
Auch hier können Sie mit Strg+Tabulator beziehungsweise Umschalt+Strg+Tabulator die 
Drehpunkte auswählen und mit den Pfeil-Tasten bewegen.

In Kreis setzen (perspektivisch)
Wählen Sie im Menü Form > und Kontextmenü Verändern > In Kreis setzen (perspektivisch).
Dieses Werkzeug verzerrt das Objekt, indem es es auf einen Kreisabschnitt projiziert. Der 
Winkel des Kreisabschnitts bedingt die Dehnung und Verformung des Objekts. Fassen Sie 
dazu einen der Ziehpunkt des Objekts an und bewegen Sie die Maus. Die Wirkung hängt 
durchaus vom Ziehpunkt ab. Abbildung 49 zeigt oben jeweils das Ausgangsobjekt und unten 
links die Wirkung beim Ausführen des Befehls, erkennbar am Phantombild, bei einem Kreis-
abschnitt von fast 90°, wobei der rechte obere Ziehpunkt ausgewählt wurde; rechts das 
Ergebnis nach dem Loslassen der Maus-Taste.
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Das Verhalten dieser Funktion kann durch die Option Extras > Optionen… > LibreOffice Draw 
> Allgemein > Objekte in Kurven nicht verzerren beeinflusst werden. Abbildung 49 wurde mit 
deaktivierter Option (der Standardeinstellung) erzeugt, aus den Quadraten wurden Kreis-
segmente. Abbildung 50 wurde mit aktivierter Option erstellt, die Quadrate behalten ihre 
Form bei.

Abbildung 49: In Kreis setzen (perspektivisch) - Option „… nicht 
verzerren“ inaktiv

Abbildung 50: In Kreis setzen (perspektivisch) - Option „... nicht verzerren“ 
aktiviert

Dabei muss das Objekt gegebenenfalls erst in eine Kurve umgewandelt werden, was zuvor 
per Dialog abgefragt wird.

Auf Kreis setzen (neigen)
Wählen Sie im Menü Form > und Kontextmenü Verändern > Auf Kreis setzen (neigen).
Im Gegensatz zum vorigen Werkzeug ist die Fläche, auf die das Objekt abgebildet wird, nicht 
ein zweidimensionaler Kreisabschnitt, sondern die zweidimensionale Abbildung eines 
gebogenen Bands, das sich von der Bildschirmoberfläche in Richtung des Betrachters biegt 
(Abbildung 51). Auch hier hängt das Ergebnis stark von der Wahl des Ziehpunkts ab, im 
Beispiel wurde wieder einer der oberen rechten Ziehpunkte verwendet. Die Option Objekte in 
Kurven nicht verzerren war inaktiv.
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Abbildung 52 zeigt das Ergebnis bei aktivierter Option.

Abbildung 51: Auf Kreis setzen (neigen) - Option „… nicht verzerren“ inaktiv

Abbildung 52: Auf Kreis setzen (neigen) - Option „… nicht verzerren“ aktiviert

Verzerren
Wählen Sie im Menü Form > und Kontextmenü Verändern > Verzerren.
Dieses Werkzeug verzerrt ein gegebenes Objekt nach unterschiedlichen Prinzipien.
Das linke Bild in Abbildung 53 zeigt das Ausgangsobjekt.
Das mittlere Bild zeigt den Zustand bei der Bearbeitung, wenn ein Eckziehpunkt verschoben 
wurde: das Objekt wird auf ein rechteckiges Raster projiziert, dessen einer Eckziehpunkt 
dann verschoben wird, was ein allgemeines Viereck produziert, entsprechend wird das 
Objekt verzerrt. Das Ergebnis, aus technischen Gründen nicht hundertprozentig identisch, 
zeigt das rechte Bild.
Wird dagegen ein mittiger Ziehpunkt eine Seite verschoben (Abbildung 54), so bedeutet dies 
einfach eine Scherung in Kombination mit einer Größenänderung: das linke Bild zeigt die 
Scherung in waagrechter Richtung, die gestrichelte Linie ist eine Fanglinie (siehe Kapitel 3 – 
Arbeiten mit Objekten und Objektpunkten des Handbuchs Draw), die das exakte Verschieben 
in dieser Richtung erleichtert; das mittlere die Größenänderung in vertikaler Richtung, das 
rechte die Kombination beider.
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Abbildung 53: Verzerrung vom Eckpunkt aus

Abbildung 54: Verzerren vom Seitenmittelpunkt aus

Umwandeln
Die hier zusammengefassten Funktionen lassen sich nur über Form > Umwandeln oder im 
Kontextmenü Umwandeln aufrufen. Es bietet sich die folgende Auswahl (Abbildung 55):

Umwandeln in Kurven, Polygone oder Kontur
Die ersten drei Menüpunkte werden am Besten zusammen 
behandelt, da sie Gemeinsamkeiten haben und sich teilweise 
überschneiden. Hier wird die Anwendung dieser Funktionen auf 
Zeichnungsobjekte beschrieben, die Anwendung auf Bilder, die 
teilweise andere Ergebnisse liefert, finden Sie in Kapitel 6 – 
Bilder bearbeiten (Rasterbilder) des Handbuchs Draw.

Art der Umwandlung
Alle drei genannten Funktionen wandeln ein Zeichnungsobjekt in 
eine Menge von Polygonen oder von Bézierkurven um, wobei der 
Begriff Bézierkurve von LibreOffice auch schon im Sinn einer Kombination mehrerer 
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elementarer Bézierkurven verstanden wird, die aneinander anschließen. Eine Ellipse 
beispielsweise wird in diesem Sinn noch als eine Bézierkurve aufgefasst, nur wenn die 
Selektion mehrere Ellipsen umfasst, die sich nicht überschneiden, enthält die Ergebnismen-
ge mehrere Elemente, wenn sie sich überschneiden, ist die Bézierkurve entsprechend 
kompliziert.
Abbildung 56 zeigt das Ergebnis einer Umwandlung einer Ellipse.

Abbildung 56: Umwandlung in 
Polygon (links) und Bézier (rechts)

• die Umwandlung in ein Polygon erzeugt einen Streckenzug, eine Aneinanderreihung 
von geraden Strecken, die aneinander anschließen und für das Auge bzw. die Auflö-
sung des Bildschirms oder Drucks eine ausreichende Annäherung an eine Kurve 
darstellen. Intern werden hier die einzelnen benötigten geraden Strecken zwischen 
den durch die vielen Quadrate erkennbaren Punkten als Kombination von Anfangs- 
und Endpunkt gespeichert.

• die Umwandlung in eine Kurve erzeugt eine Folge von Bézierkurven, die aneinander 
anschließen. Die Anzahl der dafür benötigten Punkte auf der sichtbaren Darstellung 
ist daher deutlich geringer, allerdings werden für jede Kurve weitere Parameter 
benötigt, die die Ziehpunkt der Bézierkurve beschreiben (siehe Kapitel 11 – 
Fortgeschrittene Zeichentechniken des Handbuchs Draw).

• die Umwandlung in eine Kontur scheint im Wesentlichen abhängig von der Art der 
Ausgangsgrafik entweder ein Polygon oder eine Bézierkurve zu sein. Allerdings beste-
hen im Detail in den Daten des Objekts kleine Unterschiede zwischen einem in Kontur 
umgewandelten und einem in ein Polygon bzw. in eine Kurve umgewandelten Objekt, 
die sich allerdings optisch nicht zeigen.

Bearbeitung des umgewandelten Objekts
Das Ergebnis der Umwandlung ist entweder (im allgemeinsten Fall) ein Menge von Polygo-
nen oder von Bézierkurven. Diese können Sie nun bearbeiten.
Dazu müssen Sie die Punktbearbeitung aktivieren. Dafür gibt es die folgenden Wege:

• das Menü Bearbeiten > Punktbearbeitungsmodus umschalten (F8)
• Kontextmenü Punktbearbeitungsmodus umschalten (F8)
• das Symbol Punktbearbeitungsmodus umschalten (F8)

Damit ist zunächst nur die Punktbearbeitung aktiviert, was Sie daran sehen können, wenn 
das Objekt ausgewählt ist (Abbildung 56).
Damit Sie die Punkte tatsächlich bearbeiten können, müssen Sie gegebenenfalls die 
Symbolleiste Punkte bearbeiten aktivieren (über das Menü Ansicht > Symbolleisten > Punkte 
bearbeiten, siehe Abbildung 57).
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Abbildung 57: Symbolleiste Punkte bearbeiten

Hier werden nur die Symbole besprochen, die nicht nur bei Bézierkurven aktivierbar sind, die 
Behandlung der Bézierkurven im Gesamtzusammenhang erfolgt in 
Kapitel 11 – Fortgeschrittene Zeichentechniken des Handbuchs Draw.

Punkte verschieben
Wenn dieses Symbol aktiv ist, können Sie einen Punkt des Objekts anklicken und ihn 
verschieben. Die Wirkung hängt nun vom Typ des Objekts ab:

• ist es ein Polygon, so werden die Verbindungslinien zwischen dem Punkt und seinen 
Nachbarpunkten links und rechts einfach als Gerade verändert.

• Ist es eine Bézierkurve, dann werden auch Bézierkurven von diesem Punkt zu den 
beiden Nachbarpunkten erzeugt, die Sie dann anschließend durch weitere Bearbei-
tung verändern können (siehe Kapitel 11 – Fortgeschrittene Zeichentechniken).

Abbildung 58 zeigt das Verschieben anhand eines gefüllten Polygons, das ein Rechteck 
darstellt.

Abbildung 58: Punkt 
verschieben

1. Stellen Sie sicher, dass das Symbol Punkte verschieben aktiv ist.
2. Zeigen Sie mit der Maus auf den Punkt den Sie verschieben möchten; das Bild des 

Mauszeigers wird durch ein kleines Quadrat ergänzt.
3. Bewegen Sie bei gedrückter Maus-Taste den Mauszeiger an die gewünschte Stelle.
4. Lassen Sie die Maus-Taste los.
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Abbildung 59 zeigt das unterschiedliche Ergebnis anhand der beiden Zeichnungsobjekte. 
Links das Verschieben eines Punktes eines Polygons, was einfach eine Größen- und 
Lageveränderung der beiden Verbindungslinien zwischen dem Punkt und seinen Nachbar-
punkten bewirkt, rechts das Ergebnis einer Verschiebung eines Punkts einer Bézierkurve. Die 
verfügbaren Punkte sind in diesem Fall weiter gestreut, daher ist die Basis der Änderung 
schon größer. Darüber hinaus sind die Kurven aber hier gebogen und nicht linear.

Abbildung 59: Punktverschiebung bei Polygon und Bézierkurve

Ohne Maus können Sie wie üblich einen Punkt durch wiederholtes Strg+Tabulator ansteuern 
und ihn dann mit den Pfeil-Tasten verschieben; mit Esc schließen Sie die Aktion ab.

Punkte einfügen

Abbildung 60: Punkt 
einfügen

1. Aktivieren Sie das Symbol Punkte einfügen.
2. Der Mauszeiger wandelt sich in ein Fadenkreuz.
3. Klicken Sie auf eine Stelle am Rand oder innerhalb des Objekts und lassen Sie die 

Maus-Taste los. Der neue Punkt wird eingefügt und die Kontur des Objekts entspre-
chend verändert (zumindest, wenn Sie nicht exakt die Umrandung getroffen haben). 
Der Punkt wird dabei in die Kante eingefügt, die seiner Position am nächsten liegt.

Ohne Maus ist das Verfahren etwas komplizierter:
1. Aktivieren Sie das Symbol Punkte einfügen.
2. Der Mauszeiger wandelt sich in ein Fadenkreuz.
3. Wählen Sie Umschalt+irgendeine Pfeil-Taste: der Mauszeiger wird im Inneren des 

Zeichnungsobjekts positioniert.
4. Verschieben Sie das Fadenkreuz dann mit Umschalt+Pfeil-Taste
5. Betätigen Sie Umschalt+Eingabe: der neue Punkt und die neuen Kanten werden als 

Phantombild angezeigt.
6. Betätigen Sie ein weiteres Mal Umschalt+Eingabe: die Änderung wird wirksam.
7. Schließen sie die Aktion mit Esc ab.
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Punkte löschen
Wählen Sie einen Punkt des Polygons oder Kurve aus und betätigen Sie dann das Symbol 
Punkte löschen oder die Entf-Taste: der Punkt wird gelöscht, die Kontur entsprechend 
angepasst.

Bézier schließen
Dieses Symbol gilt entgegen seinem Namen auch für Polygone (diese bestehen aus Bézier-
kurven des Grades 1). Ist es aktiviert, dann ist das Objekt gefüllt, andernfalls hat es keine 
Füllung.

Umwandeln in ein dreidimensionales Objekt
Mit der Wahl des Menüpunktes In 3D können Sie aus einem flachen Objekt ein dreidimensi-
onales erzeugen (Abbildung 61). Dabei handelt es sich um eine Extrusion und ist keine 3D-
Rotation, siehe Kapitel 7 - Arbeiten mit 3D Objekten des Handbuchs Draw.

Abbildung 61: Umwandeln in ein dreidimensionales Objekt

Dieses Objekt können Sie nun im dreidimensionalen Raum drehen und kippen. Das Objekt 
muss dazu in den Drehmodus versetzt werden, der an den runden Punktmarkierungen wie in 
Abbildung 62 rechts erkennbar ist. Sie erreichen das durch einfachen weiteren Klick, wenn 
das Objekt markiert ist oder durch zweimal klicken auf das Objekt.

Abbildung 62: Drehen und Kippen eines 3D-Objektes

• Den Mittelpunkt, hervorgehoben durch den Punkt mit zusätzlichem Fadenkreuz, 
können Sie verschieben, um die Dreh- oder Kippachse zu verändern.
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• Durch Verschieben eines Eckziehpunkts drehen Sie das Objekt ohne Änderung seiner 
Geometrie, allerdings ändert sich die Farbgebung aufgrund der Änderung im Raum 
und der darauf fußenden Belichtung.

• Durch Bewegen der Ziehpunkte mittig der Seiten, können Sie das Objekt in 
waagrechter oder senkrechter Richtung kippen.

Weitergehende Aktionen mit 3D-Objekten werden in Kapitel 7 – Arbeiten mit 3D Objekten 
des Handbuchs Draw beschrieben. 

Umwandeln in 3D-Rotationskörper
Das Beschreibung hierzu finden Sie in 
In einen 3D-Rotationskörper umwandeln auf Seite 43.

Umwandeln in Bitmap
Bei dieser Auswahl wird der derzeitige Zustand des Objekts als Rastergrafik „eingefroren“, 
das Objekt wird also als zweidimensionales Konstrukt behandelt. Verschiebungen der 
Eckziehpunkte ändern die Größe, Verschiebungen der Seitenmittelpunkte verschieben das 
umrahmende Rechteck zum Parallelogramm, mit entsprechender Änderung des Objekts. 
Das Objekt kann über das Kontextmenü Speichern… als Rastergrafik gespeichert werden.

Umwandeln in Metafile
Der Sinn dieser Umwandlung erschließt sich noch nicht ganz. Sie entspricht grundsätzlich 
dem vorigen Punkt, allerdings lässt sich das Objekt nicht per Kontextmenü speichern.
Sie können aber das markierte Objekt per Menü Datei >Exportieren exportieren und dort den 
gewünschten Dateityp auswählen (Abbildung 63).

Abbildung 63: Datei > Exportieren - mögliche Dateitypen
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Weitere Informationen

Draw Startbildschirm

Abbildung 64: Draw Startbildschirm mit Legende
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Draw Seitenleiste Eigenschaften

Abbildung 65: Seitenleiste Eigenschaften in Draw mit Legende
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Draw Symbolleiste Linie und Füllung

Abbildung 66: Symbolleiste „Linie und Füllung“ mit Legende
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Kapitelübersicht - Draw Handbuch
Kapitel 1 - Einführung in Draw
Kapitel 2 - Zeichnen von Formen
Kapitel 3 - Arbeiten mit Objekten und Objektpunkten
Kapitel 4 - Objekteigenschaften ändern
Kapitel 5 - Arbeiten mit mehreren Objekten
Kapitel 6 - Bilder bearbeiten (Rasterbilder)
Kapitel 7 - Arbeiten mit 3D Objekten
Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme
Kapitel 9 - Text einfügen und formatieren
Kapitel 10 - Drucken, Exportieren, E-Mailen
Kapitel 11 - Fortgeschrittene Zeichentechniken
Anhang B - Optionen
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Handbücher der LibreOffice Community
Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die 
Kapitelübersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation
LibreOffice Handbücher (auf deutsch) / https://tdf.io/dedocs
LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications
LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung
• Calc - Tabellenkalkulation
• Impress - Präsentationen
• Draw - Zeichnungen
• Base - Datenbanken
• Math - Formeleditor

Die Kapitel
Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-
Suite vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen
Alle Kapitel können frei als PDF-Version heruntergeladen werden:
LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren
Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice
LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie 
Windows, GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.
LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der 
Gemeinschaft der Stiftung The Document Foundation / 
https://de.libreoffice.org/about-us/governance/. Die Stiftung hat ihren Sitz in Berlin / 
Deutschland.
Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Draw Handbuch
Kapitel 1 - Einführung in Draw
Kapitel 2 - Zeichnen von Formen
Kapitel 3 - Arbeiten mit Objekten und Objektpunkten
Kapitel 4 - Objekteigenschaften ändern
Kapitel 5 - Arbeiten mit mehreren Objekten
Kapitel 6 - Bilder bearbeiten (Rasterbilder)
Kapitel 7 - Arbeiten mit 3D Objekten
Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme
Kapitel 9 - Text einfügen und formatieren
Kapitel 10 - Drucken, Exportieren, E-Mailen
Kapitel 11 - Fortgeschrittene Zeichentechniken
Anhang B - Optionen
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Hilfe
So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe
Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.
Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.
Betätigen Sie die Taste F1, (bei Laptops evtl. Fn+F1).

Online-Hilfe
Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.
Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:
LibreOffice online Hilfe

Offline- und Online-Hilfe
Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.
Im oberen Bereich befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe eingeben. 
Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiterem Buchstaben konkretisiert sich die Auswahl.
Klicken Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren 
Bereich des Fenster zu lesen.

Noch Fragen?
Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:
Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice
Besuchen Sie uns auch auf der Seite Dabei sein!:
LibreOffice Community

Spenden
LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die 
rein freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software 
gefällt, freuen wir uns über eine Spende auf Spenden für die Document Foundation.
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